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1. Introduction 
Unisys Enterprise Output Manager, or EOM, is a multi-purpose print management system. It supports routing, 
distribution, and transformation of print streams from a variety of sources to a variety of destinations. While 
“print” originally implied line images from text-only print spoolers on mainframe systems, today “print” 
sources also include data files, email, XML, and just about anything else that can be represented as bytes and 
sent between systems over a network. 

EOM was originally developed to process output from Unisys OS2200 systems, but it has long had an 
interface with the Print System that is part of the Unisys MCP operating system. It can also accept input from 
LPR clients (a Unix printing protocol supported  by many systems), email, message queuing interfaces, file 
system directories, and a number of other types of sources. It can route output to a variety of Windows and 
other printers, PDF files, email, disk files, web sites, user-written programs, plus others. Some of these 
capabilities require add-ons to the basic EOM package, but many are available right out of the box. 

EOM is a Microsoft Dot-Net application. It runs under NT-class versions of Windows—XP and later for 
workstations and Server 2003 and later for servers. It communicates to most of its sources and destinations 
over a TCP/IP network, but can take local files as input and output to the local file system and directly-
attached printers. 

In this presentation, we will demonstrate how to install and configure EOM to process print requests from an 
MCP system. We will show how you can use EOM for four basic, but generally useful applications: 

1. Standard line-image printing from the MCP. 

2. Sending an MCP print request as an email message. 

3. Printing from the MCP to a laser printer with a form overlay. 

4. Generating a PDF file from an MCP print request. 

EOM has lots of capabilities and lots of options. Because of this, setting it up initially can appear to be 
somewhat daunting. This presentation guides you step-by-step through the process of installing and initially 
configuring EOM on a system, and then modifying that configuration to support each of the capabilities listed 
above. 

ClearPath MCP servers bundle the Departmental Edition of EOM as part of their standard software set, the 
Integrated Operating Environment, or IOE. This version is adequate for most small and mid-sized operations, 
and even for some large ones. There is an Enterprise Edition available for very large environments that 
exceed the capacity of the Departmental Edition. 



EOM from Scratch  page 2 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

2. Installation and Initial Configuration 
To begin working with EOM, you will need the following: 

 The EOM software release CD-ROM. In this presentation we will be using EOM version 9.0. 

 A Windows workstation or server (XP or later) upon which to install the EOM server. 

 A Windows workstation or server upon which to install the EOM client (may be the same system as 
the one for the EOM server). 

 An MCP system with which to generate print requests. 

 The EOM print server software for the MCP Print System. Originally this was released as part of the 
EOM product, but for quite a few years now it has been released as part of the ClearPath MCP IOE. It 
is typically installed on the halt/load disk family as OBJECT/DEPCON or (DEPCON)OBJECT/DEPCON. 

 If you will be emailing from EOM, you will need access to an SMTP mail server. Typically  you will 
need to know the host name or IP address of the server. Some servers require log-on credentials in 
order to send messages. 

 If you plan to generate PDF output from EOM, you will need a PDF printer driver. The options for 
this will be discussed in the section on PDF printing. 

Additional components required in some of the later steps will be discussed as part of those steps. 

One of the first questions to ask is where the EOM server software should be installed. If you are going to be 
sending a lot of print requests to EOM, you will probably want to install it eventually on a server-grade 
system with sufficient disk, memory, and processor capacity to meet your needs. Two common candidates are 
the Windows side of a vmMCP server and your print server. The print server generally makes a nice choice, 
as EOM will have local access to the printers that are serviced by that server.  

When first starting out, you should probably install both the EOM server and client on a workstation that you 
can work on directly. That will make it easier and safer to experiment and make mistakes. Once you have 
EOM working and are more comfortable with it, you can move the software to its production environment. 

EOM is a Microsoft DotNet application, and for EOM 9.0, the system hosting it must have the .Net 
Framework version 4.0 installed. If that version of the framework is not present on the system, the EOM 
install with halt with the dialog box below.  
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The EOM CD-ROM contains the installer for the DotNet framework under the “\Microsoft 
Redistributables” folder. Once you have the framework installed, just start (or restart) the EOM 
installation as discussed below. 

There are three components of EOM to install: 

1. The EOM server. 

2. The EOM client. This can be installed on the same system as the server, but it also can be installed 
any other workstation that has network connectivity to the server system. For the purpose of this 
presentation, we will assume the client and server software will be installed on the same system. 

3. The Sentinel Alert Service (SAS). This is an optional component, but highly recommended, as 
discussed later, below.  

EOM is installed using a standard Windows MSI. To install the software, simply insert the CD-ROM and 
wait for the auto-play applet to launch. You will see a panel similar to the one shown in the figure at the start 
of the next section.  
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2.1. Installing the EOM Server Component 

 

To get started, click the first large button on the auto-play applet to install the server component, which as the 
button indicates, runs as a Windows service.  
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The EOM installer uses a standard wizard interface. The panel above signals the start of the wizard sequence. 

 

Click Next, accept the license terms, and click Next again. 
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There are a few options for installing portions of the EOM software and supporting materials. A Typical 
install is suitable for most installations, but in this presentation we are going to click the Custom button to see 
what those options are. 

 

The panel above shows the options that I typically select. Under the Documentation node, I typically unselect 
the Flash videos but install all of the other documentation. Installing extra items you won’t be using will not 
hurt anything; it just takes up some extra disk space. You can also rerun the installer later to load components 
you did not select during the original installation. 
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Note: If you are installing under Vista, Windows 7, Server 2008, or later versions of Windows, you probably 
do not want to install into the default Program Files folder. The reason is that EOM has traditionally placed 
sub-folders for both its application and data under its install folder. That worked reasonably well under earlier 
versions of Windows, but the later versions place restrictions on the access that applications and users can 
have to folders under Program Files, especially for writing. A better approach is generally to install in a 
different location, e.g., C:\Unisys\EOM\ and give that folder the privileges you need. 

 

Once you select the items you want to be installed, click the Install button to start the actual installation of 
software. 
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When the installer finishes, the panel above will display. Note the checkbox at the bottom. 

 

If you leave the box at the bottom of the final install panel checked when you click Finish, the installer will 
open the EOM help file to the section that discusses post-installation tasks and considerations. This is useful 
information, and I recommend that you read it at this point, or make a note to come back to it later. 

As mentioned above, the EOM server runs as a Windows service. It configures the service, but does not start 
EOM automatically. This is good, because you may need to adjust that service configuration first. 

One of the most important considerations in setting up EOM is the Windows user account under which that 
service will run. By default, the service is configured to run under the Local System account. This account has 
a very high level of privilege for accessing local resources on the system, but alas, local accounts cannot 
access network resources in a Windows domain (Active Directory) environment. 

If EOM will need to connect to network shares for printers or disk folders, it will need to run under a domain 
account. To change the account under which EOM runs, open the Window Services applet. On most systems 
you can access this via Control Panel > Administrative Tools > Services. On most systems you will also need 
administrator privileges to do the following. 

Unisys recommends that EOM run under an account with administrative privileges—at least an account with 
those privileges locally on the system where the service is running. The Windows Local System account 
meets that need if you do not require access to network resources. EOM requires access to the registry and 
other privileged system functions. If you are installing on Vista, Windows 7, Server 2008, or a later operating 
system, running the service under an administrative account may be required, regardless. 
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The Services applet looks like the figure above. Scroll down to the entry for Unisys Enterprise Output 
Manager and double-click it to open a dialog box for that service’s configuration. Do not start the EOM 
service yet. 
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The General pane of this dialog box displays by default. It shows that the service is not currently running. 
Click the Log On tab. 
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The Log On tab shows that the service is currently configured to run under the Local System account. To 
change that to a domain account, first click on the This account radio button. 
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Enter the fully-qualified domain user name (i.e., prefixed by the Windows domain name and a backslash), 
along with that account’s password. You must enter the password twice, but it will not be verified by 
Windows until the service actually starts. Click OK when finished to close the properties dialog box, but do 
not start the service yet. We’ll get to that shortly. 

 

If necessary, Windows will adjust the account so that it has rights to log on as a service. Although you 
normally change the EOM log-on account to use a domain account, you can also configure EOM to use a 
different local account, as shown in the example above. The “.\” indicates a local-system account. 

This completes the initial installation and setup for the EOM server. Next, we will install the client 
component. 
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2.2. Installing the EOM Client Component 

 

The next piece to be installed is the client component. This can be installed on the same system as the EOM 
server, or on another workstation that has network connectivity to the server system.  

The EOM license permits you to install your copy of the server software on only one computer system. The 
client software, however, may be installed on as many systems as you wish. I recommend that you install the 
client on at least the server system, but if it will be more convenient to configure and monitor EOM from 
another workstation (say, at your desk), install the client wherever you wish. 

Functionality of the client is the same regardless, although of course the response is usually somewhat 
snappier if you are running the client on the same system as the server component. I typically run the client on 
the server through Terminal Services (Remote Desktop Connection), which generally gives very good 
response time, even remotely over a VPN. 

Note that if the service is running on Vista, Server 2003, or a later version of Windows, the Remote Registry 
service must be running on the server in order for external clients to work properly. This service does not 
normally run automatically. 
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The client component also has a very basic installation process. 

 

Review and accept the license terms. 
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As with the server, the Typical option is fine for most purposes. There are no software options. The only 
selections you can modify affect the amount of help information that is installed. 

 

I generally install everything except the Flash demos. 
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As usual, click the Install button to begin the actual installation. 

 

And click Finish when the client installation completes.  
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2.3. Installing the EOM Sentinel Alert Service 

 

Since EOM runs as a service, it has no native user interface.  This allows it to operate when no user sessions 
are active on the system where it is running. EOM can be monitored from the client interface, but you 
probably do not want someone watching the client all of the time.  

The Sentinel Alert Service (SAS) provides a mechanism for EOM to inform the outside world when 
something happens that may require attention. Using SAS is entirely optional, but I highly recommend that 
you install it and configure it for basic alert notification, as we will do in this presentation. 

SAS is a subset of the Unisys Single Point Operations (SPO) product. If you use SPO, you can connect EOM 
to your existing SPO instance for alert notifications. In that case SAS need not be installed. 

SAS is typically installed on the same server as EOM, but it need not be. It can be installed on any other 
Windows system to which the EOM server has network connectivity. SAS also runs as a Windows service. If 
installing on another server, make sure that any intervening firewalls can pass TCP ports 5003, 5005, 5006, 
and 5007. 

To begin the installation, click the bottom button on the auto-play applet’s panel. 
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SAS requires only a very basic installation process. You can usually just click through the wizard’s panels 
and accept the defaults. 

 

You can chose the location of the SAS software and log files separately, but typically you can just accept the 
defaults. 
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Click Install to begin actual installation of the software. 

 

When installation finishes, click the Finish button to exit the installer. We will configure the SAS component 
a little later from the EOM client interface. 
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You are done with the installation CD-ROM for now, so you can also click Exit on the auto-play applet and 
remove the CD from the drive. 

2.4. Installing Software Updates 

Before proceeding further, this would be a good time to download any updates for the EOM components and 
install them on top of the base release. 

 

Go to the Unisys support site at http://support.unisys.com, log on with your support account credentials, open 
the “Solutions” tree node, and click on the link for Enterprise Output Manager. 
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Click on the “Fixes” link to view available software updates. 
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You will normally want to download both the Server and Client updates and install them. There are updates 
for additional components on this page as well, including the MCP print driver for EOM. 

These updates are standard Windows executables. You just run them to apply the changes to the base release. 
You will need to accept the license terms again, and will also be give the opportunity to change the selection 
of installed components (documentation, help files, etc.) Installing the upgrade may require you to reboot the 
server system. 
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We are finally ready to begin using EOM. In order to do so, the service must be active. Go to the Services 
applet on the server system. If the EOM service is not already running, right-click its entry and select Start. 
You could also take the heavy-handed approach and just reboot the server, as EOM is configured to start 
automatically after a reboot. If you installed SAS, it should already be running, and will also start 
automatically after a reboot. 

2.5. EOM Access Control 

The next thing to consider is controlling access to the server. By default, access from the EOM client is 
controlled by a local group, Output Manager Administrators, defined on the system that is hosting the EOM 
service. Users of the EOM client must be members of this group. If you attempt to connect to an EOM server 
and your Windows user account is not a member of an EOM administrator group, your access will be denied.  

The EOM installer creates this local group if necessary when you install the server component, but it does not 
add any users to the group. You will need to add your user account to the group, along with any other users 
who should have access to the EOM server. After adding a user to the group, you may need to log off the 
client workstation and log back on for the new privileges to be recognized and take effect.  

To add a user to the EOM group, you need to open the Windows applet that maintains user groups. Note that 
you must do this on the system where the EOM server instance is installed, and you must have local 
administrator rights on that system to do the following. 

There are a couple of ways to access the group applet, depending on the version of Windows you are using, 
but a fairly reliable one is to use: 

Start > Control Panel > Administrative Tools > Computer Management 
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Drill down in the tree on the left-hand pane of the resulting window, opening  

System Tools > Local Users and Groups > Groups 

 

Double-click the Output Manager Administrators group in the right-hand pane to open the group and view 
its members. 
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You can add new members by clicking the Add… button and entering one or more users in the resulting 
dialog box. 

EOM can implement role-based security by defining additional user groups and configuring their privileges 
within the EOM client. This is advanced topic, and beyond the scope of this presentation. 

Two additional local user groups are used to control access and administration of alerts and the Sentinel Alert 
Service: 

 SPO Administrators lists the users who are allowed to configure alert policies and how SAS 
responds to alerts. 

 SPO Users lists the users who are allowed to access the viewing and monitoring features of SAS, but 
not the administrative ones. 

If you will be configuring the alert service, you will also need to add your user account to the SPO 
Administrators group, using the same procedure as described above for the Output Manager Administrators 
group. 

2.6. Starting the EOM Client 

Once you have privileges established to access the EOM server, start the EOM client. It should be on the 
Windows Start Menu under Unisys Enterprise Output Manager Client 9.0 (or whatever version you have 
installed).  
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The client communicates with the server over a TCP/IP socket, even when both components are running on 
the same system. The first time you run the client, it will not know where the server is (or which server, since 
a single client instance potentially can be used with multiple EOM server instances). The client will display 
the following dialog box so that you may specify the appropriate server. 

 

Enter a descriptive name in the Display name combo box at the top of the dialog. It can be the same as the 
server’s hostname. This will be used to identify individual instances in case you use the client with multiple 
EOM servers. Enter the server’s host name or IP address in the second box. The default port number is 8086. 
If you need to change this, it needs to be done on both client and server, so don’t do it just yet. Make sure than 
any firewalls (including Windows Firewall on the EOM server) will allow connections on the port you are 
using. 

It is possible to encrypt the connection between client and server, but that capability needs to be configured 
the same way on both sides. This is an advanced technique we will not cover in this presentation, so leave the 
box unchecked. 

If you are not a member of the Output Manager Administrators group on the server system, you will see an 
error similar to the following.  

 

You (or an administrator) must update the local user group on the EOM server and add your Windows 
account before you will be able to proceed. Remember that you will need to log off and log back on to have 
your new group membership recognized. 
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Assuming you are able to connect successfully to the EOM server, the client will open its main window and 
display something similar to the following: 

 

This window is configurable. It supports a number of lists showing the status of various EOM entities and 
activities. You configure the lists you want to see either by clicking buttons in the toolbar or by selecting them 
from View menu. You can also control which columns appear on each list and how they are sorted. These 
configurations also can be saved in files and recalled later.  

For the purpose of this presentation, change the window to display the Printer Management, Print Job 
Management, File Management, and Events lists and close the other lists. You can adjust the size of each list 
by dragging the top border of its title bar up or down. You can also rearrange the lists by dragging the title 
bars above or below other lists.  For now, configure each of the first three lists to show a few lines apiece, and 
give the remaining space to the Events list. 

At this point, something useful to do would be to configure your client to connect to this server by default. 
That will avoid having to select a server each time you run the client. To do this, select Tools > Options from 
the menu bar to open the options dialog box. In the left-hand panel, click on the Service Connection item 
under Client Options, as shown in the next figure. 
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In the drop-down list for Connection action at startup, select “Connect to default server.” Below that, select 
the desired server name from the Default server list and click the OK button. The next time you run the 
client, it will automatically attempt to connect to that server. 

2.7. Configuring the Sentinel Alert Service 

This next section is optional, but highly recommended. If you installed the Sentinel Alert Service (SAS), it 
will need to be configured before it will do anything useful. Start by opening the Alert Explorer, either by 
selecting it from the Tools menu, or clicking its icon on the toolbar. 

Keep in mind that you must be a member of the SPO Administrators user group in order to configure the alert 
service. If you have not yet done so, add your user account to that group and then log off and back on to 
establish that privilege. 
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The main window of the Alert Explorer shows any alerts that have not been cleared. You will probably see an 
informational alert indicating the EOM service has started on its server. You can dismiss this alert by right-
clicking on it and selecting Clear… from the context menu. The resulting dialog box allows you to enter a 
comment that will be associated with the alert in the EOM log. 

 

What we are going to do is configure SAS to send us an email each time EOM generates an alert. In order to 
do that, we need a script that SAS can call and pass some information. A sample script is installed with SAS 
under its directory, typically in a path similar to: 

C:\Program Files\Unisys\Enterprise Output Manager\SAS\data\alarm-scripts 
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There is another sample script in the materials that accompany this presentation. You can use these as-is, or 
customize them to suit your preferences. Both of these scripts use Microsoft CDO-SYS to send emails, so at a 
minimum, you will need to modify them to specify the name of your mail server. 

The first step in the configuration  process is to select the server where SAS is running. Typically SAS is 
installed on the same server as EOM, but it may be installed on a different one if desired. In the Alert 
Explorer, select Configuration > Select SAS Server from the menu bar.  

 

In the New SAS Server box, enter the name of the server where SAS is installed – “localhost” should work 
if SAS is installed on the same server as EOM. Click OK to finish. If you are displaying the Events list in the 
EOM client, you should see messages to the effect that the SAS server selection has been changed. 

SAS gives you the ability optionally to filter alerts on a variety of conditions. This topic is outside the scope 
of this presentation, but if you are interested, you can access the Alert Filter Editor from the Configuration 
item on the menu bar and consult the EOM help for instructions on using it. 

The main task in configuring SAS for EOM is specifying an alert policy. An alert policy has two components, 
one or more Action Lists that specify the sets of alerts to be acted on, and one or more templates that specify 
what action is to be taken. You can have multiple alert policies, and switch among them, but only one policy 
can be in effect at a time.  

EOM installs a default alert policy, but let’s build our own. To keep things simple, we will configure the 
system to act on any alert and send an email message when it occurs. To begin, select Configuration > Alert 
Policy Editor from the Alert Explorer’s menu bar. A new window for the editor will open, showing the 
default (and currently inactive) policy created by the EOM install. 
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To create a new alert policy, select the Alert Policies node in the tree under your EOM server’s name, then 
select File > New Alert Policy from the menu bar. This will create a new policy with a default name. Click 
on the new policy’s name in the upper-right-hand pane to display its properties in the lower-right-hand pane 
and change its name to something meaningful. In this example, we will call it “DefaultPolicy”. 



EOM from Scratch  page 32 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

 

An alert policy has two main components: 

 Action Lists, which identify the alerts to be acted upon. 

 Templates, which identify the action to be taken. Each Action List is associated with exactly one 
Template, but a Template can be referenced by any number of Action Lists. 

Since Templates are referenced by Action Lists, we will configure a Template first. There are three types of 
Templates—Command (execute a Windows command), Modem (establish a dial-up connection through a 
telephone modem), and Serial (send data through a serial port). We want to send an email message when an 
alert occurs, and as discussed above, and we have a VBScript file that is able to accept parameters from SAS 
and compose an email message, so we want to configure a Command Template.  

Select the Templates node for our policy in the left-hand pane, then select File > New Template > Command 
Template from the menu bar. The editor creates a new template with a default name. Click that new template 
in the upper-right pane, then change its name to something meaningful in the lower-right pane properties. In 
this presentation, we’ll name it “EmailOnDefaultAction”. 



EOM from Scratch  page 33 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

 

Since this is a Command template, we need to specify the command the system should execute. VBScript 
scripts can be initiated with either the cscript.exe or wscript.exe commands. Since it will be initiated 
from a service, we should use cscript.exe. 

The exact nature of the command to use depends on how the script was designed. In this case, we are using a 
script that is designed to accept one or two parameters, the first being a list of “to” email addresses and the 
(optional) second one being a list of “cc” email addresses. Therefore, in the Command property for the 
template, we could specify something like this: 

cscript.exe C:\Projects\UNITE\2012-EOM-from-Scratch\Samples\EOM-Alert-Mailer.vbs 
“paul.Kimpel@digm.com, fred@support.biz” “theboss@support.biz” 

That is all that is needed for a Template. The next thing to configure is an Action List. When you create a new 
policy, the editor creates two default Action Lists for it: 

 <global> will be activated when any alert is triggered 

 <default> will be activated when an alert is triggered that is not handled by another Action List. 

You can create your own action lists if you want to respond to some alerts but not others, or if you want to 
take multiple actions for a single alert. The name of the Action List identifies the alert that will activate it, 
e.g., “PrintJobDisabled” or “SmtpError”. A complete list of these names can be found in the Alert Explorer 
help under “List of Alerts.” They are also included in the Action List that the installer created. 
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To keep things simple in this presentation, we will use the existing <global> Action List. Since we will not 
need the <default> list, first disable it by right-clicking on its node in the left-hand pane, and then changing its 
Enabled property to False in the lower-right pane. Next, click on the <global> list and make sure that it is 
enabled. 
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Now click on the <global> node in the left-hand pane, and in the blank area in the upper-left pane, right-click 
and select New Action. This will create a new Action Event of type “Raise,” which is what we want. The 
other types are “Acknowledge” and “Clear.” 
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You can specify a delay value for an Action Event, which will delay initiating the response to the alert by the 
specified amount of time. We will leave that at zero in this case. Make sure that the Enabled property is True. 
Select the template we defined a short while ago for the Template property. Leave the Text property blank. 
For a Command Action List, this text is appended to the end of the template’s Command text, so it could be 
used to supply parameters to the command.  

This completes configuring the new Alert Policy. Select File > Save All Changes from the menu bar. 

The final step is to activate our new policy. You can define as many policies as you wish, but only one can be 
active at a time. Right-click on the policy node in the left-hand pane and select Activate. Close the Alert 
Policy Editor and the Alert Explorer windows. 

To test our new policy, we will stop and restart the EOM service, which you can do from the Windows 
Services applet. The email addresses specified in the Template’s Command property should receive two 
messages that look similar to the following, one signaling that the EOM service is stopping and other that it 
has restarted: 

 

 

Now that we have an EOM server installed and configured to let us know if it has a problem, let’s do 
something productive with it. 
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3. Printing from the MCP through EOM 
For our first case study, we will configure both EOM and an MCP system to send a simple print request and 
have EOM print it. This will not accomplish anything that we cannot do quite easily using just the MCP Print 
System, but it will introduce some basic EOM concepts and show us how to connect the MCP and EOM 
environments. 

 

 

EOM is configured through its Configuration Explorer. When activated from the EOM client, this opens a 
separate window with a traditional two-pane “explorer” interface—a tree of entities in the left pane, and 
details for the currently-selected entity in the right pane. 

To open the Configuration Explorer, select Tools > Configuration Explorer from the menu bar of the client, or 
click the Configuration Explorer icon in the toolbar. 

EOM has a large number of entity types, which can appear daunting when you first start working with its 
configuration. For our purposes, we only need to work with a few of these—the rest can be ignored until you 
are ready to work with more advanced EOM features. 

In this section, we will go through the following sequence of events: 

1. Establish a configuration file for the MCP’s EOM print driver. 

2. Configure an MCP virtual printer that will send requests to EOM. 

3. Add a “listening path” to EOM so that it will be able to receive requests from the MCP system. 

4. Configure an EOM “physical printer.” 

5. Configure an EOM “print attribute” for plain old line-image printing. 

6. Configure an EOM “file mask” to recognize the MCP print request when it is received and handle it 
accordingly. 

7. Test the configuration by modifying the destination of an MCP print request. 

3.1. Configuring the MCP Print System 

The first step is to configure the Print System on the MCP to send requests to EOM. You will need MCP 
privileged user and SYSTEMUSER privileges to do the following activities. 

The EOM print driver for the MCP requires a configuration file. This file is named by appending “/CONFIG” 
to the name of the print driver’s object code file. That object code file is typically named *OBJECT/DEPCON or 
(DEPCON)OBJECT/DEPCON on the halt/load family, but it can be named anything. You can also set up an SL for 
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it, e.g., DEPCONSUPPORT. For this demonstration, we will assume the driver is *OBJECT/DEPCON ON DISK and 
therefore the configuration file must be named *OBJECT/DEPCON/CONFIG ON DISK. 

The configuration file is a simple CANDE SEQDATA file. An example file is installed with the MCP driver and 
can be modified for your site. Most of the options in the top part of the file can be left at their defaults, but the 
following shows the settings I typically use.  

LOCALSOCKETDEF=         102 
REMOTESOCKETDEF=        102 
MAXSESSIONDEF=          5 
RECVFILE-COMM=          TCP             . TCP, HLCN, NONE 
RECVFILE-COMMNAP=       IH101 
RECVFILE-ACCESS=        PRIVATE         . PRIVATE, PUBLIC 
RECVFILE-USERCODE=      TEST 
RECVFILE-PACK=          DISK 
RECVFILE-BANNER=        FALSE 
DEBUGFILE-PACK=         DISK 
SENDPINGBLOCKS=         7 
FORMIDISPAPERTYPE=      TRUE            . TRUE, FALSE 
FILENODEMASK=           FIRSTTWO . REQUEST,FIRSTTWO,LASTTWO,FIRSTLAST 
RECOVERY=               FALSE           . TRUE, FALSE 
LOGGING=                TRUE            . TRUE, FALSE 
CHARTRANSLATION=        ASCII           . ASCII, SHIFTJIS 
PRINTIDENTIFIER=        REQUESTNAME 
PUTBLANKINLINESKIP=     TRUE 
. 
.                                             LOCAL   REM    PING 
. ROUTE  DESTINATION  HOSTNAME        SOCKET  TSAP    TSAP   BLOCKS 
. -----  -----------  --------        ------  ----    ----   ----- 
  ROUTE  DIGMGX5A     192.168.209.188   102   GX5A    VMMA     7 

At the bottom of the file are the specifications for the remote EOM server(s) this MCP system will connect to. 
The specification for each destination is prefixed with the ROUTE keyword. These specifications are normally 
written on one line per destination, but in fact the syntax is free-form. 

 DESTINATION specifies a name that will be used in the Print System configuration discussed next. 

 HOSTNAME is the host name or IP address of the EOM server 

 SOCKET specifies the TCP port number over which communications will take place. This must match 
the port number specified in the EOM Configuration Explorer’s listening path. 

 LOCAL TSAP and REM TSAP are not used in simple, one-way MCP-to-EOM configurations and can be 
any string of alphanumeric characters. 

 PING BLOCKS specifies the number of blocks that will be transmitted to the EOM server before the 
MCP print driver requests an acknowledgment. The global default is specified by the 
SENDPINGBLOCKS option in the top part of the file. Seven is a good choice in the general case. 

These ROUTE specifications are not strictly required for simple, one-way MCP-to-EOM configurations. These 
statement can be used to associate a destination name with an IP address, but if a mapping between 
destination name and IP address is already established (e.g., through NW TCP/IP MAPPING or the domain-
name system), ROUTE statements are not necessary and may be omitted. 
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The contents of this configuration file, along with the rest of the MCP printer driver configuration and use, is 
described more fully in the Enterprise Output Manager for ClearPath OS 2200 and ClearPath MCP 
Configuration and Operations Guide (7850 4362). 

 The next step is to configure a printer in the MCP Print System. There are two ways that the Print System can 
send print data to EOM: 

 As an I/O Handler (IOH). In this mode, the Print System extracts individual lines from the printer-
backup file, applies any transforms or formatting specified by the attributes of the print request, and 
passes the individual lines to the EOM print driver. Using this mode may force EOM to treat the 
request as a “pass-thru,” since the Print System has already applied any formatting or device-specific 
controls. 

 As a Virtual Server. In this mode, the Print System simply passes the EOM print driver a whole 
printer-backup file and leaves it up to the print driver to process the file. Since the Print System does 
not process individual lines in the file, it cannot apply any transforms or formatting to the print file, 
such as PAGECOMP attributes. Those attributes are visible to the print driver, however, and some are 
passed over the wire to the EOM server. 

In general, if you want the nature of printing to be controlled by EOM, it is generally better to configure the 
MCP printer as a Virtual Server. Virtual Servers also generally require less overhead on the MCP system, 
since the Print System does not need to process individual lines in the file. For this presentation, we will set 
up the printer as a Virtual Server. 

The following Print System will configure a new MCP printer for use with DEPCON: 

PS CONFIG + SERVER TOEOM  
SERVER="DEPCONSERV(DIGMGX5A/MCPPS/) IN *OBJECT/DEPCON ON DISK",  
FORMID="*DONTCARE*",  
VFU=USE,  
HEADER=SUPPRESSED,  
TRAILER=SUPPRESSED,  
PRINTERKIND=LINEPRINTER, 
BLOCKSIZE=4000, 
BLOCKSTRUCTURE=UNBLOCKED, 
TRANSLATION  = (NONE), 
PROTOCOL     = NONE, 
PPT          = NONE, 
SPOOLER      = NONE, 
COMPRESSION  = NONE, 
SERVERPRIORITY = 50  

The most critical part of this is the SERVER attribute, which must be specified as a quoted string. 

1. DEPCONSERV is the name of the Virtual Server entry point in the print driver library.  

2. The IN clause at the end of the attribute value specifies the print driver code file. You can indicate 
either the code file title for the library, or SL followed by the function name for the library.  

3. The parentheses after the entry point name contain options for the connection to the EOM server: 

a. The first token after the opening parenthesis identifies the EOM server to which this MCP 
printer will send its requests. This should match one of the DESTINATION names you 
previously configured in the OBJECT/DEPCON/CONFIG file, or it should be a name that can be 
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resolved by MCP networking or a DNS server on the network to the IP address of the EOM 
server. 

b. The second token (after the first “/”) specifies a printer name by which this printer will be 
known within the EOM server. As we will see shortly, this name (referred to as the 
Destination Printer) can be used in EOM File Masks to identify incoming requests and 
determine how a request should be processed.  

c. After the second “/”, additional options can be specified, including compression of the data 
between the MCP and EOM servers, carriage-control overrides, and alternate EOM servers if 
the first one is not responding. See the Configuration and Operations Guide mentioned above 
for details on these other options. 

In the printer configuration above, we have specified FORMID=”*DONTCARE*”. To print a request, the printer’s 
FORMID value must match the print request’s FORMID value. Configuring the special “*DONTCARE*” value 
allows the printer to process a print request with any FORMID value. This is especially useful with EOM 
printers, as we will be using FORMID as a way to inform EOM how we would like a particular print request to 
be handled. That will be covered later in the sections on printing to email and PDF. 

Once you create the Print System printer on the MCP side, you can direct print requests to it as for any other 
MCP printer. At this point we have put in place the mechanism for the MCP Print System to connect to the 
EOM server and send print requests to it. You can obviously set up multiple printers to send requests to 
multiple EOM servers. You can also set up multiple printers to send requests to the same EOM server.  

There are a couple of reasons why you might want to set up multiple printers from one MCP system to one 
EOM server. One would be to improve throughput if you have very high printing loads. Another is request 
differentiation. Each MCP printer effectively becomes a separate queue of print requests for the EOM server, 
and the EOM server can recognize the individual queues and take different action based on the queue from 
which a request comes. 

The next step in the process is to create the entities that will allow EOM to receive a print request from the 
MCP and to control how the request is to be formatted. 
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3.2. Configuring an EOM Listening Path 

 

The next step is to configure a “listening path” in EOM so that it will be able to accept requests from the MCP 
Print System.  

In the EOM client, open the Configuration Explorer. Right-click on Communication Listening Paths in the 
left-hand pane of the Configuration Explorer window and select Add… Fill in the resulting dialog box as 
shown in the figure above.  

You can choose any name you wish, as that is used only within EOM. Make sure the path is enabled. You can 
specify more than one for the number of connections, but one is usually sufficient for moderate levels of 
activity. The default and recommended TCP port for communicating with EOM is 102, so use that default. 

Regardless of the port number you choose, make sure that any firewalls between the MCP and EOM servers 
will accept connections on that port, especially the Windows Firewall settings on the server. 

3.3. Configuring an EOM Physical Printer 

Our first task is to configure a “physical printer.” EOM supports a wide variety of printers. In particular, it can 
output to essentially any printer that has a Windows printer driver.  
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For this demonstration, we will configure an existing Windows laser printer as an EOM physical printer. In 
order to do that, the printer must be visible to the EOM server. The printer can be defined as a local printer on 
the server, or it could be a connection to a shared printer elsewhere on the network. One advantage of 
installing the EOM server on a Windows print server system is that most of the printers it may need to access 
are probably already defined on that print server. 

To begin, right-click on the Physical Printer node in the left-hand pane and select Add…  
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A dialog box will open to accept the properties of the new printer. Give the printer a name by which it will be 
known within EOM. Optionally enter a comment describing the printer or its location. Fill in the rest of the 
properties as shown in the figure above. You can give the printer any name you want, and you will need to 
select from the list of Windows printers currently configured on the system hosting the EOM server. Note that 
if you are running the client on a different system, you are configuring EOM on its server, not on your local 
system. The printer will need to be visible to the server.  

When you are finished, click OK. The new printer will show as a node subordinate to the Physical Printers 
node in the left-hand pane of the Configuration Explorer. It will be highlighted in boldface to indicate that its 
configuration has not yet been saved. Save it now, so that it will be established for the next step. 

In the toolbar of the Configuration Explorer, there are two diskette icons. Clicking the one showing a single 
diskette will save only the currently-selected entity. Clicking the one showing two diskettes will save all 
entities which have unsaved changes. 

EOM also supports Logical Printers. In the MCP Print System these are known as printer groups—sets of 
physical printers that are pooled to work from the same print queue in parallel. You can generally specify 
Logical Printers in EOM any place you can specify a Physical Printer. 
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If you flip over to the EOM client’s main window, you will see that the new printer now appears in the 
Printer list. There is one more step we should take in configuring this printer—setting its “paper type.” This 
is equivalent to the MCP FORMID attribute. In order to print, the printer’s paper type must match that of a 
request that is routed to that printer. If there is a mismatch, the request is placed on hold until the mismatch is 
resolved. This is similar to the way FORMID works within the MCP Print System. 

The easiest thing for us to do at this point is to configure the printer to accept any paper type. To do that, 
double-click the printer name in the Printer list, select “(Any)” from the list of paper types, and click OK. 

3.4 Configuring an EOM Print Attribute 

Go back to the Configuration Explorer on the EOM server. Expand the Print Attributes node, right-click on 
the Default entry under that node, and select Clone… from the context menu. This will create a new Print 
Attribute from the settings for an existing one. A dialog will open to configure the new Print Attribute. 

Print Attributes contain a lot of options. The next two figures show how you might configure the attribute for 
plain, line-printer style printing. The boldface entries represent the ones we have changed from EOM’s built-
in Default attribute. 
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For this simple case, most of the Print Attribute settings are not terribly critical. As you might expect, whole 
sections of this dialog (e.g., Command Files, Web/File Output) do not apply for this simple situation. In 
summary, here’s what a Print Attribute specifies: 
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General Specifies a name for the attribute as it will be known within EOM. It’s a good 
idea to specify a comment that describes what this attributes does and how it’s 
intended to be used. Data Dependent and Indexed attributes are used with add-
on features of EOM. 

Page 
Settings 

Specifies the page size and layout in terms of lines and columns, and whether 
long lines will be truncated or wrapped. 

Hardware Specifies the type of printer driver that this Print Attribute will be used with. If 
you specify a specific printer, that printer is used only to determine what fonts 
are available. Any font that you specify must be available on the EOM server at 
the time the request is printed. This section also specifies the paper size, 
orientation, and duplexing options, along with the page margins. Most laser 
printers have a narrow unprintable region around the edges of the paper (usually 
about 0.3 inches); Ignore driver margins=Yes indicates that this physical 
margin is included in the margin you specify. 

Command 
Files 

Used with form overlays (as we will see later) and Data Dependent Attributes. 

Header/ 
Trailer 
Page 

Can be used to specify a header (“banner”) and trailer page for the job, and to 
have EOM automatically output a page header showing the name of the file 
being printed, date, time, and page number. 

Web/File 
Output 

This section is used when EOM is outputting a request to a file instead of a 
printer device. We will use this section later when creating PDFs. 

Advanced This section contains miscellaneous settings that control how EOM interprets 
the data in the incoming request. It is possible to have EOM modify how it 
formats the print data within a request by embedding specially-coded line 
images in the print data. Many of the options in this area determine whether 
EOM looks for those special line images or ignores them. See the help file for 
details. I have set these options to ignore any special formatting commands. 

After completing the entries, click OK to create the attribute. You can save it now or wait until after the next 
step. 

3.5. Configuring an EOM File Mask 

Perhaps the most critical piece of configuration for EOM print requests is the File Mask. This entity 
determines how the print request will be processed. A File Mask contains three main parts: 

1. Specification of some general attributes. 

2. File selection criteria. These consist of a set of tests against the attributes of the incoming print 
requests. If the request matches the specified criteria, it is selected by this file mask and the job 
creation criteria applied to it. 

3. Job creation criteria. These consist of one or more EOM job initiation specifications. A single print 
request can result in multiple EOM jobs being initiated against that request. 
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To create a File Mask, right-click on the File Masks node in the Configuration Explorer’s left-hand pane and 
click Add… A dialog window will open to enter the attributes for the new mask. 

 

Enter a name for the File Mask by which it will be known within EOM. It is a good idea to enter a comment 
describing what this mask does. You should also enable the mask. The File Group will be discussed shortly. 
For now, just select EOM’s built-in Default file group. 

Next, we need to create the File Selection Criteria. Click on the Mask Statements line to highlight it, then 
click on the ellipsis (…) button that appears at the far right. This will open a dialog for entering criteria, as 
shown in the figure below. 
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Each incoming print request has a number of attributes, or fields, associated with it. In configuring a File 
Mask, you create one or more tests against these fields. You typically configure the mask so that all of the 
tests must be true in order for the request to match this mask, but you can also configure the mask to match if 
any test is true.  

Because different request-originating systems have different fields associated with their requests, this dialog 
allows you to filter the available fields by selecting the type of source in the drop-down list at the top, as 
shown for MCP Fields in the figure.  

In this case, we will create just one test, that the Destination Printer field has a value of  MCPPS. If you 
will recall, that is the value we specified in the Print System configuration on the MCP for our EOM printer. 
Additional tests can be inserted by clicking the Add button. 

When you have finished, click OK to insert the mask statement into the File Mask. 

Once an incoming print request has been selected, we need to tell EOM what to do with it For that we use the 
Job Creation section of the File Mask dialog. EOM supports a number of different kinds of jobs: 

 Print Jobs. These are probably the most common. They send the data from the print request to a 
printer, or a device that presents itself to EOM as a printer driver. 

 Transfer Jobs. These are used to transfer print requests among EOM servers, typically for 
distribution and remote printing. 

 Backup Jobs. These are used to make backup copies of the files under EOM’s management, typically 
for archival or regulatory compliance purposes. You can also use this capability to offload files to 
another system or device for long-term storage. 

 Email Jobs. These are used to reformat print requests as email messages and send them to an email 
server. 



EOM from Scratch  page 50 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

 Custom Jobs. These are used to send the data from a print request to a separate program, outside of 
EOM, for custom processing. Custom jobs have the ability to send reformatted data back to EOM as 
new print jobs. Unisys provides a set of basic utilities on the release CD-ROM that function as 
Custom Jobs. One of these is UEOMSplit.exe, which can be used to split a print request into pieces, 
based on the values of one or two fields on each page of the file. This utility can be used, for example, 
to split a large report by customer, department, cost center, or some other field in the page heading, 
and to distribute the pieces to separate destinations. 

 Transform Jobs. These are used to convert files from one form to another. They are typically used 
with XML data, CSS style sheets, and XSLT transformation specification files. 

You can create any combination of these types of jobs within a single File Mask. 

For this simple case, we will create just a single Print Job. Click the Print Jobs entry under Job Creation, 
then click the ellipsis (…) button that appears at the far right. This will open a dialog to specify the attributes 
of the job. 

 

Creating a Print Job is really simple—you just specify which Print Attribute you want to use and which 
Physical or Logical Printer you want to use. The Print Attribute specifies how the print request will be 
formatted, and the Printer specifies where the resulting print job will be sent. You can choose whether the 
print job will be created when EOM first starts receiving the print request, or wait until after the entire request 
has been received. I typically make the latter choice. 

Note that you can create multiple Print Jobs for a single File Mask. This can be used to print multiple copies 
of one report to individual destinations (the Print Attribute also has a Number of copies attribute in its 
General section—that will print multiple copies to one destination). 

When you are finished, click OK to insert the created jobs into the File Mask. The final File Mask 
configuration should look something like the following figure. Click OK on this figure to close the dialog.  
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3.6. Configuring an EOM File Group 

The configuration done thus far is sufficient to print from the MCP, but there is one more thing that would be 
nice to do. Recall that one of the items in a File Mask is the File Group. The purpose of a File Group is to 
specify where and how EOM should store the data for incoming print requests. There are two things that are 
easy and useful to do with a File Group: 

1. Change the location where EOM stores the print data. 
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2. Specify a retention time for the data. By default, EOM will discard the print request data after all 
printing jobs associated with it have finished. By specifying a retention, EOM will hold the data for 
the specified time period before discarding it. One great thing about this feature is that you can then 
easily reprint the data from within EOM without having to rerun the program that originally generated 
that data. I typically use a retention period of seven days. 

Open the File Groups node in the left-hand pane of the Configuration Explorer and click on the Default 
entry under that node. The details for the File Group will appear in the right-hand panel, as shown below. 

 

Under File Removal Options, select a removal type and number of days as shown on the figure. If you are 
interested in seeing where EOM stores the print files for this group, open the Directory Aliases node in the 
Configuration Explorer’s left-hand pane and click on the entry for $PrintHold. You can change that, but it 
will only affect the location of data for print requests that are received after the change is saved. 

Now would be a good time to select File > Save All Items from the Configuration Explorer menu bar. Until 
the changes are saved, EOM will not be able to use them. 

3.7. Testing the Configuration 

This completes the setup for our first case study. To test whether it works, we need to send a print request 
from the MCP to the EOM server. We could run a program and direct a printer file with the file attribute 
DESTINATION=”TOEOM”, or we could take an existing request and redirect it, thus: 

PS MOD 6168 TO DESTINATION=”TOEOM” 

If we did everything correctly, the file(s) for this print request should appear on the printer we specified in 
EOM. 

Try it. 
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4. Backing Up the EOM Configuration 
Now that we have the beginnings of a configuration established in EOM, it would be good to know how to 
back that up. If you start to make serious use of EOM, you will find that you will have significant numbers of 
Print Attributes, File Masks, Physical Printers, and other entities that you have invested significant time in 
creating and refining. If you lose the configuration, all of that might be difficult to get back the way it was. 

There are three parts to the EOM configuration that need to be backed up: 

1. Configuration options for the client. 

2. Alert Policies from Sentinel Alert Service, if you chose to install and use that component. 

3. Entities from the Configuration Explorer. 

These are in addition to any other artifacts that you use with EOM, such as form overlay files. Those will 
need to be backed up separately. 

The client configuration options can be backed up by selecting Tools > Import and Export Settings > Export 
Client Settings… from the EOM client main window’s menu bar. This will open a standard file selection 
dialog box, where you can specify the name and location where the file containing the configuration options 
will be stored. It is a good idea to put a date in the name of any configuration data you save. 

The SAS Alert Policy settings are stored in the SAS/data/eai sub-folder under the EOM server’s install 
directory. You can back these up using any Windows file copy tool. 

The Configuration Explorer data is stored as a series of files under the Data folder of EOM’s install directory. 
You could back up these files directly, but a better method is to export the configuration as an XML file and 
back up that XML file. The XML file also allows you to transport the configuration to another EOM server 
and load all or part of it on that server. 

To export the configuration, select File > Import / Export… from the Configuration Explorer menu bar. The 
import/export dialog will appear in the right-hand pane. 
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For Type of file access, select XML file. Click on the File to import from or export to item, then click the 
ellipsis (…) icon on the far right to open a file selection dialog and specify the name and location where you 
want the XML file to be stored.  

Using the tree of entities shown in this pane, you can select the specific entities or types of entities you would 
like to export. When doing a partial export, you need to click the Export >>> button. To back up everything, 
simply click the Export All >>> button. 

Something that you might find useful to do is create a full export of the configuration after every significant 
change and store the XML files in an SCM or versioned repository, such as Subversion, Perforce, or the 
Unisys SURE product. Real Mainframers do not use Git. This will give you a complete historical record of 
the development of and changes to your EOM environment. 

 



EOM from Scratch  page 55 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

5. Printing as Email from EOM 
Having configured EOM to generate simple line-printer style output on paper, our next task is to output MCP 
print requests as email messages. With email output, you need to specify the to/cc/bcc email addresses, a 
message subject, a message body, and possibly some attachments. There are three main ways of specifying 
this information to EOM, with varying degrees of flexibility: 

 Specify the addresses and subject line in MCP file attributes that are passed to EOM with the print 
request. This will be handled as a Print Job by EOM. 

 Specify addresses, subject line, body, and attachments within EOM as an Email Attribute and an 
Email job. 

 Specify addresses by way of specially-coded line images embedded in the print request data. This 
obviously requires changes to the program that generates the print data on the originating system. 
This type of addressing can be used with either a Print or Email job in EOM. 

We will focus on the first method in this presentation, since it is simple to configure and can be controlled 
from the MCP side using only file attributes. The scenario for configuring email output is quite similar to the 
one we just completed for plain printing, and will include the following steps: 

1. Configure a pseudo-printer for use in formatting email messages. 

2. Configure the EOM email interface and email server we will be using. 

3. Configure a Print Attribute for use in formatting the email messages. 

4. Configure a File Mask to recognize print requests that are to be output as emails. 

5. Specify MCP printer file attributes to send email messages. 

6. Configure an E-Mail Attribute and E-Mail Job to send a message. 

5.1. Configuring an EOM Email Printer 

The first step in preparing EOM to send email is to create a special type of Physical Printer that will be used 
to process email requests. This type of printer is built in to EOM. To begin, right-click on the Physical 
Printers node in the left-hand pane of Configuration Explorer and select Add… from the context menu. 
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As usual, give the printer a name by which it will be known within EOM. The important items in this dialog 
are the printer type must be E-mail, the printer must be available, and it must be unlocked. Automatic retry on 
error is recommended, but not required. 

Once the new printer configuration is created, don’t forget to go to the main EOM window, open that printer’s 
entry, and change the paper type to “(Any)”. 

5.2. Configuring the EOM Email Interface 

The second step in preparing EOM to send email is configuration of its interface with an email server.  To do 
this, select Tools > Options from the Configuration Explorer menu bar. In the options dialog window, select 
Server Options > E-mail > Send Options. You should see a configuration dialog as shown in the figure 
below: 
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You may need assistance from your email administrator to complete the configuration of the email interface. 
You may also wish to consider using the SMTP server component of Microsoft IIS, which is bundled with all 
server and Professional/Business editions of Microsoft Windows.  

EOM supports two methods for sending email, SMTP and the older MAPI interface. SMTP is the preferred 
method, the default, the easiest to configure, and the one we will use here.  Select it in the Interface entry 
under the General heading. 

When you select the SMTP interface, an SMTP Settings section appears in the dialog box. You should 
configure these settings as follows: 

 Message text limit. EOM can send the data from the print request either as the body of the email or 
as an attachment. The text limit determines which one. If the print request formatted as email text is 
larger than the value specified for this option, it is sent as an attachment; otherwise the data is sent as 
the body of the message. My preference is to have the print data as an attachment so that it can be 
easily detached from the email message headers, thus I normally set the text limit to a low value. 

 From address. Email messages must have a “From:” address header. This can be specified in the 
attributes of a print request or in an Email Attribute, but if a request is not associated with a From: 
address, EOM will supply the address entered here as a default. Note that you can enter the address as 
a display name followed by the actual email address in “<” and “>” brackets. If the display name 
contains special characters, it should be enclosed in quotes. 
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 Domain to add if missing. If any of the email addresses supplied to EOM for this message do not 
contain an Internet domain name (i.e., the “@our.com” part), EOM will append the domain name 
specified here. Do not include the “@” in this field. 

 SMTP Transport. The specifics of configuring this section will vary widely depending on the 
specific email server you are using and the way it has been configured. This is where you will 
probably need help from your email administrator. You can send email messages to the server over 
the network, or you can configure a “pick-up” directory where message files will be placed for the 
server to recognize and process. We will use the network method. Generally you will need the 
following: 

o The host name or IP address of your email server. 

o The TCP port over which to connect to that server. The default for SMTP is port 25. 

o Knowledge of whether the connection to the email server is encrypted using SSL. 

o The user authentication method required by the email server and any necessary credentials it 
may require. To keep it simple, we have configured our email server in this example to accept 
messages from the EOM server without authentication. 

It is also possible to have an alternate message transport to the email server and to apply encryption and 
message signing to outgoing email messages. Those subjects are beyond the scope of this presentation. 

There are additional options for sending email under the SMTP Header Fields node of this dialog box, but 
these are not needed in the typical case. EOM can also receive email, as suggested by the Receive Options 
node, but that is also beyond the scope of this presentation. 

When you are finished entering the email interface options, click OK to close the dialog box. 

5.3. Configuring a Print Attribute for Sending Email 

Since the method we are using to send email is analogous to printing, we will need a Print Attribute for EOM 
to use in formatting the print request for email. Clone a new attribute by opening the Print Attributes node in 
the left-hand pane of the Configuration Explorer, right-clicking on the Default entry, and selecting Clone… 
from the context menu. 
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Enter a name for the Print Attribute and select a Printer Driver. The two typical choices are Generic and 
Generic - No FF.  The difference is that the Generic driver will insert form-feed characters between pages 
as specified by the Page Settings section of the Print Attribute. Generic - No FF will format the email 
message as continuous lines of text without form-feeds. I generally choose the latter driver. The rest of the 
settings can remain at their original values. 

5.4. Configuring a File Mask for Email 

The final piece of the configuration for sending email is to create and configure a File Mask. Open the File 
Masks node in the left-hand pane of the Configuration Explorer, right-click on the mask we created for plain 
printing (LP-Std-LJ4K in the example from the prior section), and click Clone… from the context menu. 
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Enter a name and a comment in the General section of the dialog box; the rest of the values in this section 
should have been copied from the original mask entity. 

In the File Selection Criteria section, we will keep the original mask statement and add another to it. To do 
that, click on the Mask statements entry, and then click on the ellipsis (…) icon that appears on the far right. 
In Mask Editor windows that opens, click the Add button and for the new statement specify Host Paper 
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Type equal to EMAIL. I like to make these values case-sensitive, but that is not critical. Make sure the All 
statements must be true box is checked. 

Next, under the Job Creation section, open the Print Jobs entry, then open the entry subordinate to that. 
Change the Print Attribute and Printer selections to the names of the Print Attribute and Physical Printer we 
just created for use in emailing.  

Note that we are not creating an entry under the E-mail jobs section in this case—that is a different 
type of EOM job that is used with E-mail Attributes. 

When you are finished, the result should look similar to the figure above. Click OK to close the dialog and 
create the new File Mask.  

Now that we have more than one File Mask, there is something very important to understand about how EOM 
processes a print request against them. The order of the File Masks is critical. EOM matches an incoming 
print request against the mask statements in File Masks in the order that the File Masks are listed in the 
Configuration Explorer. Therefore, File Masks with more specific selection criteria should appear above those 
with more general criteria. 

Both of our File Masks test for Destination Printer equal to MCPPS, but only the email File Mask also tests 
the Host Paper Type field. If our File Mask configured for plain printing appears first, it will capture all 
requests for that destination printer, and those will never get to the email File Mask to be tested. Therefore, 
the email File Mask should appear above the plain printing File Mask. To rearrange the order of File Masks, 
just grab one with your pointing device and move it up or down relative to the others. 

This completes the email configuration, so save all of the unsaved entities in the Configuration Explorer. 

5.5. Specifying MCP File Attributes to Send Email 

With this method of sending print requests as email messages, the destination of the message is controlled 
entirely from the MCP side using file attributes. Three file attributes are used for this: 

 DESTINATION specifies the MCP printer to use—in this case our EOM virtual printer. 

 FORMID specifies a string that will be passed with the print request. In this case we are testing against 
the value of this string in the EOM file mask to recognize the request and act on it appropriately. 
EOM refers to the FORMID as the Host Paper Type. There are other methods to recognize and act on 
a print request, but FORMID works very well in many cases. 

 NOTE is a general purpose attribute. It is a string of up to 250 characters that is passed to EOM with 
the print request. EOM parses this string looking for name/value pairs. The complete syntax for this 
string is described in Section 2.7 of the Configuration and Operations Guide mentioned earlier, but 
for email requests the following are useful: 

o DEPCON-EMAIL=<address list> 
A list of To: addresses for the message. Multiple addresses must be separated by semicolons. 
This option can be abbreviated DC-EA. You can also use DEPCON-ECARBONCOPY (DC-ECC) for 
CC: addresses and DEPCON-EBLINDCARBON (DC-EBC) for BCC: addresses. 

o DEPCON-ESUBJECT=<text> 
The subject line of the message. 
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o DEPCON-EMAIL-EXT=<file extension> 
A three-character mnemonic that identifies the format of the data (and on most email clients, 
the type of program that will open the attachment by default). The default it WRI (Microsoft 
WordPad). I generally use TXT, which will send the print data as plain text. 

There are a number of ways to specify these attribute values on the MCP—in a program’s file declaration, 
through WFL file equation, the PRINTDEFAULTS task attribute, or by modifying a print request. The following 
is an example showing how the file attributes can be used with the EOM configuration we have built: 

PS MOD 6168 TO DESTINATION=”TOEOM”, FORMID=”EMAIL”,  
NOTE=”DEPCON-EMAIL=PAUL.KIMPEL@DIGM.COM;  
      DEPCON-ESUBJECT=EMAIL TEST; DEPCON-EMAIL-EXT=TXT” 

5.6. Configure an E-Mail Attribute and E-Mail Job to Send a Message 

The previous example showed how to send an email message as an EOM Print Job and control the destination 
using MCP file attributes. This next example will illustrate how to use E-Mail Attributes and E-Mail Jobs in 
EOM. 

Note that it is possible that no File Mask will match against an incoming print request. This is not considered 
to be an error, and EOM will simply not do any thing with the request. I generally configure a File Mask at 
the bottom of the list that has no mask statements (i.e., it will select any request) and have that File Mask send 
me an email message indicating that an incoming request was not selected by one of the other File Masks.  

Since that email-me-if-nothing-happened is a useful thing to have in our EOM configuration, let’s use that as 
our E-Mail Attribute exercise. 

E-Mail Attributes are analogous to Print Attributes, in that they specify how an email message is to be 
formatted. They also provide a means to specify the email addresses, subject line, body contents, and 
attachments for the message. 

This example will also introduce the concept of EOM keywords. These are special tokens you can insert in 
many elements of the configuration. These tokens are replaced at run time by a dynamically-determined 
value. EOM has a large number of keywords. Some represent attributes of an incoming request and others 
provide environmental information, such as date and time. The EOM help contains a complete list of 
keywords and the values that will be substituted for them. 

You create an E-Mail Attribute in the usual way—by right-clicking on the E-Mail Attributes node in the 
Configuration Explorer and clicking Add… or Clone… in the context menu. That will open a configuration 
dialog similar to the following figure. 



EOM from Scratch  page 63 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

 

Note that in the figure above the To: and From: address have been specified literally, but the Subject: and 
Attachment display name entries contain tokens within “<” and “>” brackets. Those are keywords that will 
have values substituted when the E-Mail Attribute is applied to a request at run time. For MCP-originated 
requests, <ORIGFILENAME> is a text string composed from the MCP job number and job title. <MIXNUMBER> is 
the MCP mix number of the task that generated the request. These keywords are used here just to illustrate the 
concept—any number of other keywords could have been chosen in this case. 

Next, let us configure a File Mask that will allow us to use this E-Mail Attribute directly. We can then route 
print requests to the specified email address without having to specify it in the MCP’s NOTE attribute, which is 
a very convenient way to direct print requests to frequently-used destinations.  

Right-click on the File Masks node in the Configuration Explorer and select Add… from the context menu. 
Fill in the General section of the configuration dialog as we have for other File Masks and configure the File 
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Selection Criteria section to recognize a print request from Destination Printer equal to MCPPS and Host 
Paper Type equal to SENDTOPAUL (see the full mask dialog below for how this should look). 

For this File Mask, we will not configure a Print Job, but rather an E-Mail Job. Under the Job Creation 
section of the configuration dialog, click on the Email jobs entry, and then click on the ellipsis (…) icon on 
the far right.  

 

Fill in the E-mail Attribute, Print Attribute, and Printer for re-formatting file entries from the 
corresponding entities we have previously configured, as shown above. Click OK to insert this job into the 
File Mask. The final File Mask should look like the following figure: 
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Click OK on the File Mask configuration dialog to create the new mask. Ensure that the new File Mask 
appears above the plain-printing File Mask in the Configuration Explorer, then save the configuration. 

To test this we can file-equate a printer file for a program or modify an existing MCP print request, as shown 
below. Note that the way we have configured this, the FORMID completely specifies to EOM the destination of 
the message, and a NOTE attribute is not required: 
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PS MOD 6168 TO DESTINATION=”TOEOM”, FORMID=”SENDTOPAUL”  

If you do include a NOTE attribute in the print request, its settings will override those in the E-Mail Attribute. 

Having configured the E-Mail Attribute for direct selection from a File Mask, let us now create a new File 
Mask that will serve as a catch-all at the end of the list of File Masks. The easiest thing to do is clone it from 
the File Mask we just created, then: 

 Click on the Mask statements entry in the File Mask dialog, and then on its ellipsis (…) icon to open 
the Mask Statements Editor dialog. 

 Click the Remove button within the Mask Statements Editor to delete all of the mask statements. 

 Click OK to apply these changes to the new File Mask. 

The result should look like the following: 
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Click OK to create the new File Mask. Now go to the Configuration Explorer’s left-hand pane and move this 
new File Mask to the very bottom of the list of File Masks. This will ensure that it gets evaluated last. 

To test that this new File Mask actually traps incoming requests that were not selected by any other File 
Mask, you will probably need to disable the plain-printing File Mask, because it selects on nothing but the 
destination printer. To do that, just click its entry under the File Masks node in the Configuration Explorer, 
and in the right-hand pane set the Enabled option to No. Save the configuration. 

Now send an MCP print request to EOM with an obviously undefined FORMID, e.g., 

PS MOD 6168 TO DESTINATION=”TOEOM”, FORMID=”XXX”  

You should receive an email message in response to this request. When configuring a catch-all like this on a 
production system, you will probably want to create a separate E-Mail Attribute with a catchy subject line 
such as “*** EOM: No File Mask Selected ***”, or perhaps “The Programmers Screwed Up Yet 
Again”. It’s your choice. You might also want to have a separate Print Attribute that output only the first page 
or two of the data, just as a sample so you know which report did not get successfully routed by EOM. 
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6. Printing with a Form Overlay from EOM 
For our next case study, we will output an MCP print request with a form overlay to a laser or other graphics-
enabled printer. This is similar to printing on pre-printed paper forms, except that we will get EOM to apply 
the form captions, line art, and images at the time each page is printed. This allows us to use plain paper in the 
printer. 

The steps in this demonstration will be: 

1. Create the form overlay file. 

2. Create a Directory Alias within EOM to reference the overlay file. 

3. Create a Print Attribute to apply the overlay during printing. 

4. Create a File Mask to recognize and initiate an appropriate printing job. 

6.1. Creating a Form Overlay for Use with EOM 

There are two ways to generate form overlays for use with EOM. One is to generate a “page macro” in one of 
the page description languages (PDLs) and download that to the printer. This is more efficient in terms of 
printing, since the macro is downloaded only once and resides in the printer, but it has two disadvantages: (a) 
PDL macros are difficult to generate, and (b) they must be designed for a specific PDL (e.g., PCL or 
PostScript) and sometimes must be tailored to a specific brand or model of printer. 

The second form creates more work for EOM and the printer, but it much easier to set up and use. Any image 
that can be represented in the Windows Metafile (WMF) or Enhanced Metafile (EMF) format can be used by 
EOM as a page overlay. Metafiles are scalable, device independent, and easy to create. This is the approach 
we will use in this demonstration. 

To begin, you will need a drawing program that can output the graphic as a Metafile. There are many drawing 
programs that can generate WMF and EMF output, and other programs that can convert any number of 
graphic formats to WMF or EMF. Microsoft Visio and Open Office can both generate drawings and save 
them as WMF/EMF files. The program I like to use, however, is Microsoft PowerPoint. You just create the 
overlay as one “slide” that is the size of the paper you will be printing on, and save it in WMF format. 

When creating a form overlay, note that most printers have an unprintable border around all four edges of the 
paper. The width of this border varies with the printer, but is generally 0.25-0.50 inch. As a general rule, I like 
to design form overlays with a 0.5-inch border on all four sides. When printed on U.S. “A” (8.5x11-inch) 
paper, that yields a printable area of 7.5x10 inches. 

For our first example, we will go retro and create an overlay that simulates the “green bar” paper that was 
commonly used with impact printers. Drawn in PowerPoint, the overlay looks like this: 
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This image is designed to be 7.5x10 inches. The 0.5-inch border around the page is specified in PowerPoint’s 
Page Setup dialog instead of being part of the image. This overlay is simply eight light-green, border-less 
rectangles, each 0.5x10 inches in size, spaced 0.5 inch apart. We will save it in PowerPoint as a WMF with 
the name GreenBar.wmf. It’s that simple. 

6.2. Create a Directory Alias for the Form Overlay 

In order to use the form overlay, EOM must have access to it, so the form must be stored either on the EOM 
server or on a shared directory the server can access. In this case, we will store it directly on the server.  

EOM has a mechanism for identifying folders where the files it uses are stored, called a Directory Alias. You 
define the alias with a simple name and a fully-qualified directory path. Elsewhere in the EOM configuration, 
you refer to the folder by its alias instead of the full path.  

Create a new alias by right-clicking the Directory Aliases node in the Configuration Explorer’s left-hand 
pane and selecting Add… from the context menu. Fill in the fields of the dialog box as shown in the 
following figure: 
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You can type in the directory path manually, or click the ellipsis (…) icon on the far right to open a standard 
Windows browse-for-folder dialog. If the folder does not yet exist, you will need to create it before EOM will 
allow you to save the new alias. 

Now move or copy the WMF from the prior step into this folder on the server. I like to keep the PowerPoint 
file (or whatever type of file was used to generate the WMF) in this folder as well, so that it’s easy to keep 
track of the file from which the overlay was made, and allow the overlay to be modified later when necessary. 

6.3. Create a Print Attribute for the Form Overlay 

The next step is to create a Print Attribute that will apply the form overlay at printing time. The only 
difference between this new Print Attribute and the one we created initially for plain-paper printing is the 
specification of the overlay file, so the easiest thing to do is clone the new PA from the original one. 

Open the Print Attributes node in the left-hand pane of the Configuration Explorer, right-click on the LP-
Std attribute, and select Clone… from the context menu. Give the new attribute an appropriate name and 
comment. 

In the Command Files section of the Print Attribute dialog, click on the entry for Top of page Directory 
Alias and select the name of the Directory Alias we created in the prior step. Next, click the entry below that, 
Top of page command file, and select the name of the WMF file for our overlay image.  EOM automatically 
loads all of the files from that folder into a drop-down list to make this selection easy. 

Also set the Lines per page entry under Page Settings to 60, and the Lines at top and Lines at bottom 
entries to zero. The rest of the entries in this dialog can retain their existing values. Click OK to create the 
new Print Attribute. The resulting attribute should look similar to the following two figures. 
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6.4. Create a File Mask for Printing the Form Overlay 

The final step in configuring printing for the forms overlay is to create an appropriate File Mask. We can also 
clone this from an existing entry. Open the File Masks node in the left-hand pane of the Configuration 
Explorer, right-click on the mask we created for the original plain-paper printing demonstration (LP-Std-
LJ4K) and select Clone… from the context menu.  

Enter a name and comment for the new mask. Next, click on the Mask Statements entry in the dialog and 
then click on the ellipsis (…) icon to open the Mask Statements Editor dialog. Inside that dialog, click on the 
Add button to create an additional mask statement and fill it in as shown below. Once again, we will be using 
the MCP FORMID file attribute (EOM Host Paper Type) to select how the print request will be routed and 
formatted. 

 

Click OK to insert the new mask statement into the File Mask and close the editor dialog. Back on the File 
Mask dialog, open the entry for the Print Job and modify its Print Attribute to reference the new one we 
created just above.  

Because this new Print Attribute specifies our form overlay as a “top of page command file,” EOM will flash 
the form image onto the page before laying down the lines of print, effectively printing the data on top of the 
form, just like with a paper form.  

When completed, the new File Mask should look similar to the following figure. Click OK to create the new 
mask and close the dialog box. 



EOM from Scratch  page 74 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

 

There is one final step we should make. Recall that the order of the File Masks in the Configuration Explorer 
determines the order in which they are applied by EOM against incoming print requests. Like the File Mask 
for email messages in the prior section, our new File Mask for forms overlay is more specific than the original 
one we created for plain-paper printing, so if necessary, drag the new File Mask to some position above the 
original one, as shown in the next figure. 
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This completes the configuration for the form overlay demonstration, so now save the configuration. 

6.5. Testing the Form Overlay Configuration 

We can test this configuration the same way we have tested the earlier demonstrations. MCP print requests to 
be formatted with our form overlay need to be distinguished by a DESTINATION attribute of “TOEOM” and a 
FORMID attribute of “GREENBAR”. We can either apply those attributes using WFL file equation, or modify an 
existing print request, e.g., 

PS MOD 6162 TO DESTINATION=”TOEOM”, FORMID=”GREENBAR” 

If the registration of form and printing is not quite right, you will need to go back to your drawing program 
and shift or scale the drawing within its page frame. Alas, changing the margin setting in the EOM Print 
Attribute shifts both the printing and the underlying form together. 

With this type of form overlay, registration of printing with the form is largely the responsibility of the forms 
designer, as it was with pre-printed paper forms for impact printers. You will typically use a monospaced 
font, so the data from the MCP will be printing on a fixed grid, and the form must be adapted to that grid. The 
DDA (Dynamic Data Attributes) add-on to EOM provides a much more flexible way of positioning data on a 
form, so if the simple approach to forms overlay outlined in this demonstration is not sufficient, you should 
investigate DDA. 

6.6. A More Typical Form Overlay Example 

The green-bar form overlay is quite a basic example of how an image can be applied to a print request by 
EOM. This next demonstration shows a more typical example—an invoice form. Once again, the overlay is 
created using PowerPoint and saved as a WMF into the same folder on the server. The form includes a simple 
logo image that was pasted into the PowerPoint document. Otherwise, all of the line art was drawn directly in 
PowerPoint. 

The only additional things we need to do in this demonstration is clone a new Print Attribute that will 
reference the new form overlay, and a new File Mask that will select based on a different value of FORMID and 
apply the new Print Attribute. 

The following figure shows the form as it was designed in PowerPoint. The logo image extends outside the 
bounds of the form slightly, but that overlap will be trimmed to the size specified in PowerPoint’s Page Setup 
when the form is saved as EOM-INVOICE.wmf. 
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The next step is to clone a Print Attribute from the one we created in the prior forms overlay demonstration. 
Since this form is in portrait rather than landscape format, we will make appropriate changes to the 
Characters per line, Paper orientation, and Simplex / Duplex settings, as shown on the following figure. I 
have also changed the font to a different typeface and size, and specified the new form overlay file as the Top 
of page command file. The finished Print Attribute should look similar to the figure below (the parts of the 
dialog not shown have not changed from the attribute from which this one was cloned). 
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The File Mask can be cloned from the prior demonstration. All that needs to be changed is the name of the 
mask, the Host Paper Type in the second mask statement, and the Print Attribute in the Print Job entry, as 
shown below: 

 

Once again, registration of the printing with the form is a matter of agreement between the programmer 
writing the program that generates the data and the designer of the form. It’s not uncommon to require a 
couple of iterations to get things to line up properly. For an example of a program that will generate print data 
for this form, see the following, which is included as the file SOURCE.UNITE.FORMS.DEMO.c85_m in the 
examples accompanying this document. 
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Sample COBOL-85 Program to Print the Invoice Form 
000100$$ FEDLEVEL=5 
000200$$ SET LINEINFO BINDINFO 
000300$$ SET LISTOMITTED 
001000 
001100 IDENTIFICATION DIVISION. 
001200 PROGRAM-ID.    UNITE-EOM-FORMS-DEMO. 
001400 AUTHOR.        P.KIMPEL 
001500 INSTALLATION.  PARADIGM CORPORATION, SAN DIEGO CA US. 
001600 DATE-WRITTEN.  MAY 2012. 
001700 DATE-COMPILED. 
002100****************************************************************** 
002200*                                                                * 
002300*    UNITE/EOM/FORMS/DEMO                                        * 
002480*                                                                * 
002500****************************************************************** 
002600* 
002700*    THIS PROGRAM GENERATES A PRINT FILE TO FILL IN THE INVOICE 
002800*    FORMS OVERLAY USED IN THE 2012 UNITE EOM DEMONSTRATION.    
005000*                                                               
005100*    THERE IS NOTHING SPECIAL ABOUT THIS PROGRAM -- IT JUST     
005200*    GENERATES A STANDARD PRINTER FILE WITH THE INVOICE FIELDS  
005300*    POSITIONED SO THAT THEY WILL OVERLAY THE FORM IN THE       
005400*    CORRECT POSITIONS.                                         
050000* 
050010****************************************************************** 
050030* MODIFICATION LOG. 
050040* ----------------- 
050050* 2011-04-17  P.KIMPEL 
050060*    ORIGINAL VERSION, FROM MISC/FORMS/PSI-DEMO. 
099900****************************************************************** 
100000 
100200 ENVIRONMENT DIVISION. 
100400****************************************************************** 
100600 CONFIGURATION SECTION. 
100700****************************************************************** 
100800 SOURCE-COMPUTER.                UNISYS-MCP. 
100900 OBJECT-COMPUTER.                UNISYS-MCP. 
120000 
120100****************************************************************** 
120200 INPUT-OUTPUT SECTION. 
120300****************************************************************** 
120400 FILE-CONTROL. 
128000     SELECT PF-PRINT 
128100         ASSIGN TO               PRINTER. 
150000/ 
150100 DATA DIVISION. 
150200****************************************************************** 
150300 FILE SECTION. 
150400****************************************************************** 
280000 
280100 FD  PF-PRINT 
280200     RECORD CONTAINS             90 CHARACTERS 
280220     VALUE OF DESTINATION        "TOEOM" 
280240     VALUE OF FORMID             "INVOICE" 
280300     LABEL RECORDS               STANDARD. 
280400 01  PF-REC. 
280500     05 FILLER                   PIC X(90). 
280600 
280700 01  PF-INVOICE-LINE. 
280800     05 FILLER                   PIC X(5). 
280900     05 PF-INV-COMPANY-NAME      PIC X(30). 
281000     05 FILLER                   PIC X(30). 
281100     05 PF-INV-DATE              PIC 99/99/99. 
281200     05 FILLER                   PIC X(5). 
281300     05 PF-INV-NBR               PIC ZZZZZZZ9. 
281400     05 FILLER                   PIC X(4). 
281500 



EOM from Scratch  page 80 

2012 UNITE MCP-4033 & 4049  Paradigm Corporation 

281600 01  PF-SHIP-LINE. 
281700     05 FILLER                   PIC X(65). 
281800     05 PF-SHIP-DATE             PIC 99/99/99. 
281900     05 FILLER                   PIC X(5). 
282000     05 PF-SHIP-VIA              PIC X(12). 
282100 
282200 01  PF-ORDER-LINE. 
282300     05 FILLER                   PIC X(10). 
282400     05 PF-ORDER-BILL-TO         PIC X(30). 
282500     05 FILLER                   PIC X(22). 
282600     05 PF-ORDER-SHIP-TO. 
282700       10 PF-ORDER-PROD-CODE     PIC 9(6). 
282800       10 FILLER                 PIC X(4). 
282900       10 PF-ORDER-JOB-NBR       PIC 9(4). 
283000       10 FILLER                 PIC X(4). 
283100       10 PF-ORDER-TERMS         PIC X(10). 
283200 
283300 01  PF-ITEM-LINE. 
283400     05 PF-ITEM-ORDER-QTY        PIC ZZZZZZZ9. 
283500     05 FILLER                   PIC X(1). 
283600     05 PF-ITEM-SHIP-QTY         PIC ZZZZZZZ9. 
283700     05 FILLER                   PIC X(2). 
283800     05 PF-ITEM-CODE             PIC X(6). 
283900     05 FILLER                   PIC X(1). 
284000     05 PF-ITEM-DESC             PIC X(33). 
284100     05 FILLER                   PIC X(3). 
284200     05 PF-ITEM-PRICE            PIC Z(6).9(5). 
284300     05 FILLER                   PIC X(1). 
284400     05 PF-ITEM-AMOUNT           PIC ZZ,ZZZ,ZZZ.99. 
284500     05 FILLER                   PIC X(2). 
284600 
284700 01  PF-COMMENT-LINE. 
284800     05 FILLER                   PIC X(27). 
284900     05 PF-COMMENT-TEXT          PIC X(63). 
285000 
285100 01  PF-TOTAL-LINE. 
285200     05 PF-TOTAL-SUB             PIC Z,ZZZ,ZZZ.99. 
285300     05 PF-TOTAL-TAX-1           PIC Z,ZZZ,ZZZ.99. 
285400     05 PF-TOTAL-TAX-2           PIC Z,ZZZ,ZZZ.99. 
285500     05 PF-TOTAL-TAX-3           PIC Z,ZZZ,ZZZ.99. 
285600     05 FILLER                   PIC X(27). 
285700     05 PF-TOTAL-AMT             PIC ZZ,ZZZ,ZZZ.99. 
285800     05 FILLER                   PIC X(2). 
285900 
286000 01  PF-COPY-LINE. 
286100     05 FILLER                   PIC X(30). 
286200     05 PF-COPY-DESC             PIC X(30). 
286300     05 FILLER                   PIC X(30). 
300000 
300010****************************************************************** 
300020 WORKING-STORAGE SECTION. 
300030****************************************************************** 
300100 77  W-PROGRAM-NAME              PIC X(30)   VALUE 
300110             "UNITE-EOM-FORMS-DEMO". 
300500 77  W-FALSE                     PIC 9(1)    VALUE ZERO    BINARY. 
300520 77  W-TRUE                      PIC 9(1)    VALUE 1       BINARY. 
301100 77  W-X                         PIC S9(11)                BINARY. 
301110 77  W-L                         PIC S9(11)                BINARY. 
320000 
320100 01  WGC-GENERAL-CONTROL. 
320200     05 WGC-DATE-TODAY           PIC 9(6). 
320300     05 WGC-COPY-DESC            PIC X(30). 
330000 
330100 01  WM-MESSAGE-AREA. 
330200     05 WM-DISPLAY. 
330300       10 FILLER                 PIC X(10)   VALUE "FORMDEMO:". 
330400       10 WM-TEXT. 
330500         15 WM-STATUS-VALUE      PIC ----,---,--9B. 
330600         15 WM-STATUS-TEXT       PIC X(67). 
500000/ 
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500200 PROCEDURE DIVISION. 
510100****************************************************************** 
510200 0000-MAIN-SECTION SECTION. 
510300****************************************************************** 
510400 0000-MAIN-LINE. 
510500*    MAIN LINE INITIALIZATION AND DRIVER CODE. 
510600 
511000     OPEN OUTPUT PF-PRINT. 
511010     MOVE SPACE TO PF-REC. 
511020     ACCEPT WGC-DATE-TODAY FROM TODAYS-DATE. 
511100 
511200     MOVE "CUSTOMER COPY" TO WGC-COPY-DESC. 
511300     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
511400 
511450$$ SET OMIT 
511500     MOVE "SHIPPING COPY" TO WGC-COPY-DESC. 
511600     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
511700 
511800     MOVE "ACCOUNTING COPY" TO WGC-COPY-DESC. 
511900     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
512000 
512100     MOVE "SALES COPY" TO WGC-COPY-DESC. 
512200     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
512300$$ POP OMIT 
519000 
519100     CLOSE PF-PRINT. 
519300 
519400 0000-EXIT. 
519500     STOP RUN. 
600000 
600100****************************************************************** 
600200 0100-GENERATE-PAGE. 
600300*    FORMATS ONE DEMO INVOICE PAGE. 
600400 
600405     MOVE SPACE TO PF-REC. 
600410     WRITE PF-REC BEFORE 4 LINES. 
600495 
600500     MOVE SPACE TO PF-REC. 
600600     MOVE WGC-DATE-TODAY TO PF-INV-DATE. 
600700     ACCEPT PF-INV-NBR FROM TODAYS-DATE. 
600800     WRITE PF-REC BEFORE 4 LINES. 
600900 
601000     MOVE SPACE TO PF-REC. 
601100     MOVE WGC-DATE-TODAY TO PF-SHIP-DATE. 
601200     MOVE "0" TO PF-SHIP-VIA. 
601300     WRITE PF-REC BEFORE 4 LINES. 
601400 
601500     MOVE SPACE TO PF-REC. 
601600     MOVE "SAMPLE CUSTOMER" TO PF-ORDER-BILL-TO. 
601700     ACCEPT PF-ORDER-PROD-CODE FROM TIMER. 
601800     ACCEPT PF-ORDER-JOB-NBR FROM TIMER. 
601900     MOVE "N30D" TO PF-ORDER-TERMS. 
602000     WRITE PF-REC BEFORE 1 LINE. 
602100 
602200     MOVE SPACE TO PF-REC. 
602300     MOVE "P.O. BOX 12345" TO PF-ORDER-BILL-TO. 
602400     WRITE PF-REC BEFORE 1 LINE. 
602500 
602600     MOVE SPACE TO PF-REC. 
602700     MOVE "SAN ANTONIO, TEXAS  78299" TO PF-ORDER-BILL-TO. 
602800     WRITE PF-REC BEFORE 1 LINE. 
602900 
603000     MOVE SPACE TO PF-REC. 
603100     MOVE "ATTN: ACTS. PAYABLE 9921" TO PF-ORDER-BILL-TO. 
603120     WRITE PF-REC BEFORE 1 LINE. 
603140 
603160     MOVE SPACE TO PF-REC. 
603200     MOVE "SAMPLE CUSTOMER" TO PF-ORDER-SHIP-TO. 
603300     WRITE PF-REC BEFORE 1 LINE. 
603400 
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603500     MOVE SPACE TO PF-REC. 
603600     MOVE "5122 ENTERPRISE COURT" TO PF-ORDER-SHIP-TO. 
603700     WRITE PF-REC BEFORE 1 LINE. 
603800 
603900     MOVE SPACE TO PF-REC. 
604000     MOVE "SAN ANTONIO, TEXAS" TO PF-ORDER-SHIP-TO. 
604100     WRITE PF-REC BEFORE 1 LINE. 
604200 
604300     MOVE SPACE TO PF-REC. 
604400     MOVE "U.S.A.  78311" TO PF-ORDER-SHIP-TO. 
604500     WRITE PF-REC BEFORE 6 LINES. 
604600 
604700     MOVE SPACE TO PF-REC. 
604800     MOVE 850000 TO PF-ITEM-ORDER-QTY. 
604900     MOVE 720090 TO PF-ITEM-SHIP-QTY. 
605000     MOVE "058" TO PF-ITEM-CODE. 
605100     MOVE "0/5/8/S/L-DE1300-C826" TO PF-ITEM-DESC. 
605200     MOVE 0.08280 TO PF-ITEM-PRICE. 
605300     MOVE 59623.45 TO PF-ITEM-AMOUNT. 
605400     WRITE PF-REC BEFORE 1 LINE. 
605500 
605600     MOVE SPACE TO PF-REC. 
605700     MOVE "  3"" MULTI-PURPOSE OINTMENT" TO PF-ITEM-DESC. 
605800     WRITE PF-REC BEFORE 1 LINE. 
605900 
606000     MOVE SPACE TO PF-REC. 
606100     MOVE "5/8"" X 3""" TO PF-COMMENT-TEXT. 
606200     WRITE PF-REC BEFORE 1 LINE. 
606300 
606400     MOVE SPACE TO PF-REC. 
606500     MOVE "EMPTY COLLATSIBLE ALUMINUM TUBES:" TO PF-COMMENT-TEXT. 
606600     WRITE PF-REC BEFORE 1 LINE. 
606700 
606800     MOVE SPACE TO PF-REC. 
606900     MOVE "MULTI-PURPOSE OINTMENT 1% - 5G." TO PF-COMMENT-TEXT. 
607000     WRITE PF-REC BEFORE 1 LINE. 
607100 
607200     MOVE SPACE TO PF-REC. 
607300     MOVE "CODE: 1023443-543-55A" TO PF-COMMENT-TEXT. 
607400     WRITE PF-REC BEFORE 1 LINE. 
607500 
607600     MOVE SPACE TO PF-REC. 
607700     MOVE 14 TO PF-ITEM-ORDER-QTY. 
607800     MOVE 14 TO PF-ITEM-SHIP-QTY. 
607900     MOVE "MIS" TO PF-ITEM-CODE. 
608000     MOVE "SKIDS" TO PF-ITEM-DESC. 
608100     MOVE 8 TO PF-ITEM-PRICE. 
608200     MOVE 112 TO PF-ITEM-AMOUNT. 
608300     WRITE PF-REC BEFORE 1 LINE. 
608400 
608500     MOVE SPACE TO PF-REC. 
608600     MOVE "PALLET CHARGES" TO PF-ITEM-DESC. 
608700     WRITE PF-REC BEFORE 1 LINE. 
608800 
608900     MOVE SPACE TO PF-REC. 
609000     MOVE 1 TO PF-ITEM-ORDER-QTY. 
609100     MOVE 1 TO PF-ITEM-SHIP-QTY. 
609200     MOVE "MIS" TO PF-ITEM-CODE. 
609300     MOVE "FUEL SURCHARGE" TO PF-ITEM-DESC. 
609400     MOVE 147.14 TO PF-ITEM-PRICE. 
609500     MOVE 147.14 TO PF-ITEM-AMOUNT. 
609600     WRITE PF-REC BEFORE 1 LINE. 
609700 
609800     MOVE SPACE TO PF-REC. 
609900     MOVE "FUEL SURCHARGE" TO PF-ITEM-DESC. 
610000     WRITE PF-REC BEFORE 1 LINE. 
610100 
610200     MOVE SPACE TO PF-REC. 
610300     MOVE 14 TO PF-ITEM-ORDER-QTY. 
610400     MOVE 14 TO PF-ITEM-SHIP-QTY. 
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610500     MOVE "MIS" TO PF-ITEM-CODE. 
610600     MOVE "MISCELLANEOUS" TO PF-ITEM-DESC. 
610700     MOVE 65 TO PF-ITEM-PRICE. 
610800     MOVE 910 TO PF-ITEM-AMOUNT. 
610900     WRITE PF-REC BEFORE 1 LINE. 
611000 
611100     MOVE SPACE TO PF-REC. 
611200     MOVE "MIS" TO PF-ITEM-DESC. 
611300     WRITE PF-REC BEFORE 1 LINE. 
611400 
611500     MOVE SPACE TO PF-REC. 
611600     MOVE "CHARGE FOR TARE WEIGHT MEASUREMENT" TO PF-COMMENT-TEXT. 
611700     WRITE PF-REC BEFORE 20 LINES. 
611800 
611900     MOVE SPACE TO PF-REC. 
612000     MOVE 60792.59 TO PF-TOTAL-SUB. 
612100     MOVE ZERO TO PF-TOTAL-TAX-1. 
612200     MOVE ZERO TO PF-TOTAL-TAX-2. 
612300     MOVE 60792.59 TO PF-TOTAL-TAX-3. 
612400     MOVE 60792.59 TO PF-TOTAL-AMT. 
612500     WRITE PF-REC BEFORE 2 LINES. 
612600 
612700     MOVE SPACE TO PF-REC. 
612800     MOVE WGC-COPY-DESC TO PF-COPY-DESC. 
612900     WRITE PF-REC BEFORE 1 LINE. 
613000 
613100 0100-EXIT. 
613200     EXIT. 
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7. Printing as PDF from EOM 
For our next case study, we will output an MCP print request as PDF. In order to do that, we will need a 
suitable printer driver that generates a PDF file as output rather than a stream of data destined for a physical 
printer. 

Prior to EOM version 7.0, it was common practice to use Adobe Acrobat Distiller as a way to generate PDF 
out of EOM. Earlier versions of EOM ran as an ordinary Windows program, and Distiller worked fine in that 
environment. Starting with 7.0, however, EOM was re-implemented as a Windows service. Programs written 
as services cannot interact with the Windows desktop, and this presents a problem when trying to use 
Distiller. In some cases it may work, but it is not recommended. 

The current alternatives for EOM version 7.0 and later are two third-party printer drivers that will generate 
PDF files: 

 Dane Prairie Win2PDF (http://www.win2pdf.com/) 

 Amyuni PDF Converter (http://www.amyuni.com/) 

Both packages come in personal and server editions. Which edition you will need depends on the type of 
system that will be hosting the EOM server. If the EOM server is running on a personal edition of Windows 
(e.g., XP Pro or Vista Business), you can use the personal/desktop edition of the PDF printer drivers. If the 
EOM server is running on a server edition of Windows (e.g., Server 2003 or 2008), you will need to purchase 
the server edition of the PDF driver. The cost difference is significant. For example, the personal edition of 
Win2PDF is about $35. The server edition is about $500. 

You can, of course, use these PDF print drivers to print from any application running on the EOM server, not 
just EOM. 

In this demonstration, we will be using the personal edition of Win2PDF. Use of the Amyuni driver from 
within EOM will be the same, since both present themselves as standard Windows drivers. We will assume 
the printer driver has already been installed, which is a straightforward Windows installation process. We will 
configure a process to print the invoice form from the prior section as a PDF file. 
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7.1. Creating a PDF Printer within EOM 

The first step in configuring EOM to output PDF is to create a Physical Printer that will reference the PDF 
print driver. This new printer uses the same configuration settings as the original Windows laser printer we 
configured for the first demonstration, with two differences: 

 The Windows printer name references Win2PDF, which is the Windows printer that was created by 
the installation of the Win2PDF print driver. 

 Under Output File Options, we have selected “Print to file.” This will cause EOM to capture the 
output of the printer as a file on disk. Make sure the Action to perform… is (None). 

The configuration of the PDF printer is shown in the figure below. Click OK to create the new Physical 
Printer, then select it in the main EOM client window and change its paper type to “(Any)” as we have done 
for the other printers. 
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7.2. Creating a Directory Alias for the PDF Files 

Next, we need to specify a place where the PDF files will be stored after they are created. For that purpose we 
will create a new Directory Alias, as we did for the form overlay files in the prior section. The new alias 
should look similar to the following figure: 

 

7.3. Creating a Print Attribute for PDF Output 

Next, we need a Print Attribute for the PDF output. Since we are simply printing the invoice form to a 
different medium, we can clone the attribute from the one we created in the prior section, as shown in the next 
two figures: 
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There are no changes on the first part of the Print Attribute dialog, other than name and comment. 
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The significant difference in this Print Attribute compared to the one we cloned it from is in the Web/File 
Output section. We specify the Directory Alias we created just above, and in the Output Naming Rule, we 
specify a string that defines how the resulting PDF file should be named. The full rule is truncated in the 
figure above, but it ends in “.pdf”. We also specify a 365-day expiration period for the file. EOM will 
automatically purge the file from the specified directory after that time. One more thing—set the Ignore 
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embedded e-mail information entry to No. That setting won’t matter for this demonstration, but it will for 
the next one involving emailing the completed PDF file. 

Because we will probably be generating many PDF files, it is important that we have a meaningful and unique 
name for each one. This is where EOM’s keyword substitution capability comes in very handy. You can 
insert attributes from the original MCP print request such as user and file names, as well as dates and times, 
into the file name. When the “Create unique file” setting is specified, EOM will ensure that a new file 
name does not overwrite an existing one by appending a timestamp at the end of the name if necessary. 

7.4. Creating a File Mask for PDF Output 

The next step is to create a new File Mask for this type of printing. We can clone this from the one used to 
generate paper invoice output from the prior section. All that needs to be changed is the Host Paper Type in 
the second mask statement to recognize a different MCP FORMID value, and to specify the new Print Attribute 
and Physical Printer names in the Print Job specification, as shown in the figure below: 
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After finishing the creation of these entities, save the configuration. It can be tested the same way we have 
tested the prior demonstrations, by substituting “INVOICE-PDF” for the MCP FORMID attribute. The resulting 
output looks like this: 
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7.5. Generating and Emailing PDF from EOM 

For our final demonstration, we will combine PDF generation with emailing the generated PDF. In order to 
do that, we need a new EOM Physical Printer entity that combines the PDF print driver with email capability. 
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This new printer can be cloned from the PDF printer that we created earlier in this section. The only change is 
that the Action to perform with output file entry must be changed to Generate e-mail job. The new 
printer configuration should look similar to the following example. 

 

We can reuse the Print Attribute from the prior PDF demonstration, but we will need to set up a new File 
Mask to select the PDF/email combination for an incoming print request.  

Clone a new File Mask from the one used in the prior demonstration. As before, we will use a different value 
of the MCP FORMID file attribute, “INV-EMAIL” as the basis for matching the File Mask to the incoming 
request. That value should be specified on the second mask statement for Host Printer Type. The printer 
specification in the Print Job entry should be changed to the name of the new PDF/Email printer we just 
created. The completed File Mask should look similar to the figure below. 

Note that MCP FORMID attribute values can be up to 100 characters long, but EOM Host Paper Type values 
are limited to only 12 characters. Longer FORMIDs will be truncated by the EOM driver on the MCP, and will 
typically result in a print request not being selected by the correct File Mask. 
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Save the configuration and test it by sending an MCP print job to EOM with a FORMID value of “INVOICE-
EMAIL”, and the email details in the such as the following: 

PS MOD 6162 TO DESTINATION=”TOEOM”, FORMID=”INVOICE-EMAIL” 

There are a couple of ways to supply the email address when using this technique. One is to use the NOTE 
attribute on the MCP side as we did in the first email demonstration, earlier. Another is to configure an E-mail 
attribute and create an E-mail job in the File Mask. For both of those cases, the entire print request will be 
mailed to one set of destinations. 
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If you are generating PDF copies of invoices and emailing them, you probably want to email each invoice 
separately to the appropriate customer. EOM provides a couple of ways to do that. One way is to embed the 
email address information in the print request data. This requires changes to the MCP program generating the 
print request, but it is straightforward and very flexible.  

Email command can be embedded in the print request data using print lines that begin with the sequence 
ESC-60-ESC-S, where ESC stands for the EBCDIC escape character (hex 27), and the hyphens are for 
readability and not part of this special five-character sequence. In hex, the sequence would be @27F0F627E2@. 
Following this sequence, you can output the same name/value pairs that are used in the NOTE attribute, e.g.,  

ESC-60-ESC-S DEPCON-EMAIL=AR@customer.com 
ESC-60-ESC-S DEPCON-ESUBJECT=Here is your monthly invoice 

Multiple addressees can be included by outputting multiple lines with this special escape sequence, one line 
per address. These lines can appear anywhere within the page and do not print on the form—EOM strips them 
from the print data before passing that data to the PDF print driver for formatting. 

For an example of how this is done in COBOL-85, see the following program, which is included as the file  
SOURCE.UNITE.PDF-EMAIL.DEMO.c85_m in the example materials accompanying this document. 
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Sample COBOL-85 Forms Program with Embedded Email Addresses 
000100$$ FEDLEVEL=5 
000200$$ SET LINEINFO BINDINFO 
000300$$ SET LISTOMITTED 
001000 
001100 IDENTIFICATION DIVISION. 
001200 PROGRAM-ID.    UNITE-EOM-PDF-EMAIL-DEMO. 
001400 AUTHOR.        P.KIMPEL 
001500 INSTALLATION.  PARADIGM CORPORATION, SAN DIEGO CA US. 
001600 DATE-WRITTEN.  MAY 2012. 
001700 DATE-COMPILED. 
002100****************************************************************** 
002200*                                                                * 
002300*    UNITE/EOM/PDF-EMAIL/DEMO                                    * 
002480*                                                                * 
002500****************************************************************** 
002600* 
002700*    THIS PROGRAM GENERATES A PRINT FILE TO FILL IN THE INVOICE   
002800*    FORMS OVERLAY USED IN THE 2012 UNITE EOM DEMONSTRATION TO    
002900*    PRINT TO A PDF DOCUMENT AND AUTOMATICALLY EMAIL THE          
003000*    DOCUMENT.                                                    
005000*                                                                 
005100*    THIS VERSION OF THE PROGRAM OUTPUTS SPECIAL EOM ESCAPE       
005200*    SEQUENCES TO SPECIFY THE EMAIL ADDRESS AND SUBJECT HEADING   
005300*    FOR EACH INVOICE. THE SPECIAL ESC-60-ESC-S SEQUENCE IS       
005400*    DEFINED IN WORKING-STORAGE AS WEC-EMAIL-ATTRIBUTE. THESE     
005500*    ESCAPE SEQUENCES ARE APPLIED IN THE 100-GENERATE-PAGE        
005600*    ROUTINE. THEY CAN APPEAR ANYWHERE IN THE PAGE AND WILL NOT   
005700*    PRINT ON THE RESULTING OUTPUT. MAKE SURE YOU HAVE THE EOM    
005800*    PRINT ATTRIBUTE SETTING "IGNORE EMBEDDED E-MAIL INFORMATION" 
005900*    SET TO "NO" IN ORDER FOR THESE ESCAPE SEQUENCES TO BE        
006000*    DETECTED.                                                    
050000* 
050010****************************************************************** 
050030* MODIFICATION LOG. 
050040* ----------------- 
050050* 2011-04-23  P.KIMPEL 
050060*    ORIGINAL VERSION, FROM MISC/FORMS/PSI-DEMO. 
099900****************************************************************** 
100000 
100200 ENVIRONMENT DIVISION. 
100400****************************************************************** 
100600 CONFIGURATION SECTION. 
100700****************************************************************** 
100800 SOURCE-COMPUTER.                UNISYS-MCP. 
100900 OBJECT-COMPUTER.                UNISYS-MCP. 
120000 
120100****************************************************************** 
120200 INPUT-OUTPUT SECTION. 
120300****************************************************************** 
120400 FILE-CONTROL. 
128000     SELECT PF-PRINT 
128100         ASSIGN TO               PRINTER. 
150000/ 
150100 DATA DIVISION. 
150200****************************************************************** 
150300 FILE SECTION. 
150400****************************************************************** 
280000 
280100 FD  PF-PRINT 
280200     RECORD CONTAINS             90 CHARACTERS 
280220     VALUE OF DESTINATION        "TOEOM" 
280240     VALUE OF FORMID             "INV-EMAIL" 
280300     LABEL RECORDS               STANDARD. 
280400 01  PF-REC. 
280500     05 FILLER                   PIC X(90). 
280600 
280700 01  PF-INVOICE-LINE. 
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280800     05 FILLER                   PIC X(5). 
280900     05 PF-INV-COMPANY-NAME      PIC X(30). 
281000     05 FILLER                   PIC X(30). 
281100     05 PF-INV-DATE              PIC 99/99/99. 
281200     05 FILLER                   PIC X(5). 
281300     05 PF-INV-NBR               PIC ZZZZZZZ9. 
281400     05 FILLER                   PIC X(4). 
281500 
281600 01  PF-SHIP-LINE. 
281700     05 FILLER                   PIC X(65). 
281800     05 PF-SHIP-DATE             PIC 99/99/99. 
281900     05 FILLER                   PIC X(5). 
282000     05 PF-SHIP-VIA              PIC X(12). 
282100 
282200 01  PF-ORDER-LINE. 
282300     05 FILLER                   PIC X(10). 
282400     05 PF-ORDER-BILL-TO         PIC X(30). 
282500     05 FILLER                   PIC X(22). 
282600     05 PF-ORDER-SHIP-TO. 
282700       10 PF-ORDER-PROD-CODE     PIC 9(6). 
282800       10 FILLER                 PIC X(4). 
282900       10 PF-ORDER-JOB-NBR       PIC 9(4). 
283000       10 FILLER                 PIC X(4). 
283100       10 PF-ORDER-TERMS         PIC X(10). 
283200 
283300 01  PF-ITEM-LINE. 
283400     05 PF-ITEM-ORDER-QTY        PIC ZZZZZZZ9. 
283500     05 FILLER                   PIC X(1). 
283600     05 PF-ITEM-SHIP-QTY         PIC ZZZZZZZ9. 
283700     05 FILLER                   PIC X(2). 
283800     05 PF-ITEM-CODE             PIC X(6). 
283900     05 FILLER                   PIC X(1). 
284000     05 PF-ITEM-DESC             PIC X(33). 
284100     05 FILLER                   PIC X(3). 
284200     05 PF-ITEM-PRICE            PIC Z(6).9(5). 
284300     05 FILLER                   PIC X(1). 
284400     05 PF-ITEM-AMOUNT           PIC ZZ,ZZZ,ZZZ.99. 
284500     05 FILLER                   PIC X(2). 
284600 
284700 01  PF-COMMENT-LINE. 
284800     05 FILLER                   PIC X(27). 
284900     05 PF-COMMENT-TEXT          PIC X(63). 
285000 
285100 01  PF-TOTAL-LINE. 
285200     05 PF-TOTAL-SUB             PIC Z,ZZZ,ZZZ.99. 
285300     05 PF-TOTAL-TAX-1           PIC Z,ZZZ,ZZZ.99. 
285400     05 PF-TOTAL-TAX-2           PIC Z,ZZZ,ZZZ.99. 
285500     05 PF-TOTAL-TAX-3           PIC Z,ZZZ,ZZZ.99. 
285600     05 FILLER                   PIC X(27). 
285700     05 PF-TOTAL-AMT             PIC ZZ,ZZZ,ZZZ.99. 
285800     05 FILLER                   PIC X(2). 
285900 
286000 01  PF-COPY-LINE. 
286100     05 FILLER                   PIC X(30). 
286200     05 PF-COPY-DESC             PIC X(30). 
286300     05 FILLER                   PIC X(30). 
300000 
300010****************************************************************** 
300020 WORKING-STORAGE SECTION. 
300030****************************************************************** 
300100 77  W-PROGRAM-NAME              PIC X(30)   VALUE 
300110             "UNITE-EOM-FORMS-DEMO". 
300500 77  W-FALSE                     PIC 9(1)    VALUE ZERO    BINARY. 
300520 77  W-TRUE                      PIC 9(1)    VALUE 1       BINARY. 
301100 77  W-X                         PIC S9(11)                BINARY. 
301110 77  W-L                         PIC S9(11)                BINARY. 
305000 
305100 01  CR-CHAR                     CONSTANT AS @0D@. 
305200 01  ESC-CHAR                    CONSTANT AS @27@. 
320000 
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320100 01  WGC-GENERAL-CONTROL. 
320200     05 WGC-DATE-TODAY           PIC 9(6). 
320300     05 WGC-COPY-DESC            PIC X(30). 
330000 
330100 01  WM-MESSAGE-AREA. 
330200     05 WM-DISPLAY. 
330300       10 FILLER                 PIC X(10)   VALUE "PDFEDEMO:". 
330400       10 WM-TEXT. 
330500         15 WM-STATUS-VALUE      PIC ----,---,--9B. 
330600         15 WM-STATUS-TEXT       PIC X(67). 
350000 
350100 01  WEC-EOM-CONTROL. 
350200     05 WEC-EMAIL-ATTRIBUTE. 
350300       10 FILLER                 PIC X(1)    VALUE ESC-CHAR. 
350400       10 FILLER                 PIC X(2)    VALUE "60". 
350500       10 FILLER                 PIC X(1)    VALUE ESC-CHAR. 
350600       10 FILLER                 PIC X(4)    VALUE "S". 
500000/ 
500200 PROCEDURE DIVISION. 
510100****************************************************************** 
510200 0000-MAIN-SECTION SECTION. 
510300****************************************************************** 
510400 0000-MAIN-LINE. 
510500*    MAIN LINE INITIALIZATION AND DRIVER CODE. 
510600 
511000     OPEN OUTPUT PF-PRINT. 
511010     MOVE SPACE TO PF-REC. 
511020     ACCEPT WGC-DATE-TODAY FROM TODAYS-DATE. 
511100 
511200     MOVE "CUSTOMER COPY" TO WGC-COPY-DESC. 
511300     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
511400 
511450$$ SET OMIT 
511500     MOVE "SHIPPING COPY" TO WGC-COPY-DESC. 
511600     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
511700 
511800     MOVE "ACCOUNTING COPY" TO WGC-COPY-DESC. 
511900     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
512000 
512100     MOVE "SALES COPY" TO WGC-COPY-DESC. 
512200     PERFORM 0100-GENERATE-PAGE THRU 0100-EXIT. 
512300$$ POP OMIT 
519000 
519100     CLOSE PF-PRINT. 
519300 
519400 0000-EXIT. 
519500     STOP RUN. 
600000 
600100****************************************************************** 
600200 0100-GENERATE-PAGE. 
600300*    FORMATS ONE DEMO INVOICE PAGE. 
600400 
600405     MOVE SPACE TO PF-REC. 
600410     WRITE PF-REC BEFORE 4 LINES. 
600412 
600414     MOVE SPACE TO PF-REC. 
600416     STRING WEC-EMAIL-ATTRIBUTE, 
600418         "DEPCON-EMAIL=PAUL@EMAIL.DIGM.COM", CR-CHAR 
600420         DELIMITED BY SIZE INTO PF-REC. 
600422     WRITE PF-REC BEFORE ZERO LINES. 
600424 
600426     MOVE SPACE TO PF-REC. 
600428     STRING WEC-EMAIL-ATTRIBUTE, 
600430         "DEPCON-EMAIL=NOBODY@SBCGLOBAL.NET", CR-CHAR 
600432         DELIMITED BY SIZE INTO PF-REC. 
600434     *> WRITE PF-REC BEFORE ZERO LINES.       *> INHIBIT FOR NOW 
600436 
600438     MOVE SPACE TO PF-REC. 
600440     STRING WEC-EMAIL-ATTRIBUTE, 
600442         "DEPCON-ESUBJECT=INVOICE TEST #1 FOR UNITE", CR-CHAR 
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600444         DELIMITED BY SIZE INTO PF-REC. 
600446     WRITE PF-REC BEFORE ZERO LINES. 
600495 
600500     MOVE SPACE TO PF-REC. 
600600     MOVE WGC-DATE-TODAY TO PF-INV-DATE. 
600700     ACCEPT PF-INV-NBR FROM TODAYS-DATE. 
600800     WRITE PF-REC BEFORE 4 LINES. 
600900 
601000     MOVE SPACE TO PF-REC. 
601100     MOVE WGC-DATE-TODAY TO PF-SHIP-DATE. 
601200     MOVE "0" TO PF-SHIP-VIA. 
601300     WRITE PF-REC BEFORE 4 LINES. 
601400 
601500     MOVE SPACE TO PF-REC. 
601600     MOVE "SAMPLE CUSTOMER" TO PF-ORDER-BILL-TO. 
601700     ACCEPT PF-ORDER-PROD-CODE FROM TIMER. 
601800     ACCEPT PF-ORDER-JOB-NBR FROM TIMER. 
601900     MOVE "N30D" TO PF-ORDER-TERMS. 
602000     WRITE PF-REC BEFORE 1 LINE. 
602100 
602200     MOVE SPACE TO PF-REC. 
602300     MOVE "P.O. BOX 12345" TO PF-ORDER-BILL-TO. 
602400     WRITE PF-REC BEFORE 1 LINE. 
602500 
602600     MOVE SPACE TO PF-REC. 
602700     MOVE "SAN ANTONIO, TEXAS  78299" TO PF-ORDER-BILL-TO. 
602800     WRITE PF-REC BEFORE 1 LINE. 
602900 
603000     MOVE SPACE TO PF-REC. 
603100     MOVE "ATTN: ACTS. PAYABLE 9921" TO PF-ORDER-BILL-TO. 
603120     WRITE PF-REC BEFORE 1 LINE. 
603140 
603160     MOVE SPACE TO PF-REC. 
603200     MOVE "SAMPLE CUSTOMER" TO PF-ORDER-SHIP-TO. 
603300     WRITE PF-REC BEFORE 1 LINE. 
603400 
603500     MOVE SPACE TO PF-REC. 
603600     MOVE "5122 ENTERPRISE COURT" TO PF-ORDER-SHIP-TO. 
603700     WRITE PF-REC BEFORE 1 LINE. 
603800 
603900     MOVE SPACE TO PF-REC. 
604000     MOVE "SAN ANTONIO, TEXAS" TO PF-ORDER-SHIP-TO. 
604100     WRITE PF-REC BEFORE 1 LINE. 
604200 
604300     MOVE SPACE TO PF-REC. 
604400     MOVE "U.S.A.  78311" TO PF-ORDER-SHIP-TO. 
604500     WRITE PF-REC BEFORE 6 LINES. 
604600 
604700     MOVE SPACE TO PF-REC. 
604800     MOVE 850000 TO PF-ITEM-ORDER-QTY. 
604900     MOVE 720090 TO PF-ITEM-SHIP-QTY. 
605000     MOVE "058" TO PF-ITEM-CODE. 
605100     MOVE "0/5/8/S/L-DE1300-C826" TO PF-ITEM-DESC. 
605200     MOVE 0.08280 TO PF-ITEM-PRICE. 
605300     MOVE 59623.45 TO PF-ITEM-AMOUNT. 
605400     WRITE PF-REC BEFORE 1 LINE. 
605500 
605600     MOVE SPACE TO PF-REC. 
605700     MOVE "  3"" MULTI-PURPOSE OINTMENT" TO PF-ITEM-DESC. 
605800     WRITE PF-REC BEFORE 1 LINE. 
605900 
606000     MOVE SPACE TO PF-REC. 
606100     MOVE "5/8"" X 3""" TO PF-COMMENT-TEXT. 
606200     WRITE PF-REC BEFORE 1 LINE. 
606300 
606400     MOVE SPACE TO PF-REC. 
606500     MOVE "EMPTY COLLATSIBLE ALUMINUM TUBES:" TO PF-COMMENT-TEXT. 
606600     WRITE PF-REC BEFORE 1 LINE. 
606700 
606800     MOVE SPACE TO PF-REC. 
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606900     MOVE "MULTI-PURPOSE OINTMENT 1% - 5G." TO PF-COMMENT-TEXT. 
607000     WRITE PF-REC BEFORE 1 LINE. 
607100 
607200     MOVE SPACE TO PF-REC. 
607300     MOVE "CODE: 1023443-543-55A" TO PF-COMMENT-TEXT. 
607400     WRITE PF-REC BEFORE 1 LINE. 
607500 
607600     MOVE SPACE TO PF-REC. 
607700     MOVE 14 TO PF-ITEM-ORDER-QTY. 
607800     MOVE 14 TO PF-ITEM-SHIP-QTY. 
607900     MOVE "MIS" TO PF-ITEM-CODE. 
608000     MOVE "SKIDS" TO PF-ITEM-DESC. 
608100     MOVE 8 TO PF-ITEM-PRICE. 
608200     MOVE 112 TO PF-ITEM-AMOUNT. 
608300     WRITE PF-REC BEFORE 1 LINE. 
608400 
608500     MOVE SPACE TO PF-REC. 
608600     MOVE "PALLET CHARGES" TO PF-ITEM-DESC. 
608700     WRITE PF-REC BEFORE 1 LINE. 
608800 
608900     MOVE SPACE TO PF-REC. 
609000     MOVE 1 TO PF-ITEM-ORDER-QTY. 
609100     MOVE 1 TO PF-ITEM-SHIP-QTY. 
609200     MOVE "MIS" TO PF-ITEM-CODE. 
609300     MOVE "FUEL SURCHARGE" TO PF-ITEM-DESC. 
609400     MOVE 147.14 TO PF-ITEM-PRICE. 
609500     MOVE 147.14 TO PF-ITEM-AMOUNT. 
609600     WRITE PF-REC BEFORE 1 LINE. 
609700 
609800     MOVE SPACE TO PF-REC. 
609900     MOVE "FUEL SURCHARGE" TO PF-ITEM-DESC. 
610000     WRITE PF-REC BEFORE 1 LINE. 
610100 
610200     MOVE SPACE TO PF-REC. 
610300     MOVE 14 TO PF-ITEM-ORDER-QTY. 
610400     MOVE 14 TO PF-ITEM-SHIP-QTY. 
610500     MOVE "MIS" TO PF-ITEM-CODE. 
610600     MOVE "MISCELLANEOUS" TO PF-ITEM-DESC. 
610700     MOVE 65 TO PF-ITEM-PRICE. 
610800     MOVE 910 TO PF-ITEM-AMOUNT. 
610900     WRITE PF-REC BEFORE 1 LINE. 
611000 
611100     MOVE SPACE TO PF-REC. 
611200     MOVE "MIS" TO PF-ITEM-DESC. 
611300     WRITE PF-REC BEFORE 1 LINE. 
611400 
611500     MOVE SPACE TO PF-REC. 
611600     MOVE "CHARGE FOR TARE WEIGHT MEASUREMENT" TO PF-COMMENT-TEXT. 
611700     WRITE PF-REC BEFORE 20 LINES. 
611800 
611900     MOVE SPACE TO PF-REC. 
612000     MOVE 60792.59 TO PF-TOTAL-SUB. 
612100     MOVE ZERO TO PF-TOTAL-TAX-1. 
612200     MOVE ZERO TO PF-TOTAL-TAX-2. 
612300     MOVE 60792.59 TO PF-TOTAL-TAX-3. 
612400     MOVE 60792.59 TO PF-TOTAL-AMT. 
612500     WRITE PF-REC BEFORE 2 LINES. 
612600 
612700     MOVE SPACE TO PF-REC. 
612800     MOVE WGC-COPY-DESC TO PF-COPY-DESC. 
612900     WRITE PF-REC BEFORE 1 LINE. 
613000 
613100 0100-EXIT. 
613200     EXIT.  

 


